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About This Manual

Introduction to the Manuals

The following manuals are supplied with your Epson printer. As well as the manuals, check the various types of
help information available from the printer itself or from the Epson software applications.

[ Start Here (paper manual)

Provides you with information on setting up the printer, installing the software, using the printer, solving
problems, and so on.

(d User's Guide (digital manual)

This manual. Provides overall information and instructions on using the printer, and on solving problems.

You can obtain the latest versions of the above manuals with the following methods.

(d Paper manual

Visit the Epson Europe support website at http://www.epson.eu/Support, or the Epson worldwide support
website at http://support.epson.net/.

[ Digital manual

Start EPSON Software Updater on your computer. EPSON Software Updater checks for available updates of
Epson software applications and the digital manuals, and allows you to download the latest ones.

Related Information
= “Software Update Tools (EPSON Software Updater)” on page 88

Using the Manual to Search for Information

The PDF manual allows you to search for information you are looking for by keyword, or jump directly to specific
sections using the bookmarks. You can also print only the pages you need. This section explains how to use a PDF
manual that has been opened in Adobe Reader X on your computer.

Searching by keyword

Click Edit > Advanced Search. Enter the keyword (text) for information you want to find in the search window,
and then click Search. Hits are displayed as a list. Click one of the displayed hits to jump to that page.

|:> = b e i 1 g o of s et e
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Jumping directly from bookmarks

Click a title to jump to that page. Click + or > to view the lower level titles in that section. To return to the previous
page, perform the following operation on your keyboard.

(4 Windows: Hold down Alt, and then press <.
(4 Mac OS: Hold down the command key, and then press <.

User's Guide

Printing only the pages you need

You can extract and print only the pages you need. Click Print in the File menu, and then specify the pages you
want to print in Pages in Pages to Print.

[ To specify a series of pages, enter a hyphen between the start page and the end page.
Example: 20-25

[ To specify pages that are not in series, divide the pages with commas.
Example: 5, 10, 15

Help (D)
Gopies: |1 & [C1Print in grayszale (black and white)
gray:
[ 5ave inkftener (L

Comments & Farms
Document an d Markups

] Seale: 9T%

827 x 1169 Inches.

(@) Pages 5
Page Sizing & Handing (0
Size Paster Multiple Eoaklet eSO |

Marks and Symbols

A Caution:

Instructions that must be followed carefully to avoid bodily injury.

g Important:

Instructions that must be observed to avoid damage to your equipment.

Note:
Provides complementary and reference information.
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Related Information

® Links to related sections.

Descriptions Used in this Manual

(4 Screenshots of the printer driver and the Epson Scan 2 (scanner driver) screens are from Windows 10 or macOS
High Sierra. The content displayed on the screens varies depending on the model and situation.

[ Tllustrations used in this manual are examples only. Although there may be slight differences depending on the
model, the method of operation is the same.

[d Some of the menu items on the LCD screen vary depending on the model and settings.

[d You can read the QR code using dedicated app.

Operating System References

Windows

In this manual, terms such as "Windows 10", "Windows 8.1", "Windows 8", "Windows 7", "Windows Vista",
"Windows XP", "Windows Server 2016", "Windows Server 2012 R2", "Windows Server 2012", "Windows Server 2008
R2", "Windows Server 2008", "Windows Server 2003 R2", and "Windows Server 2003" refer to the following
operating systems. Additionally, "Windows" is used to refer to all versions.

d Microsoft® Windows® 10 operating system

(d Microsoft® Windows® 8.1 operating system

([ Microsoft® Windows® 8 operating system

([ Microsoft® Windows® 7 operating system

[ Microsoft® Windows Vista® operating system

(J Microsoft® Windows® XP operating system

(J Microsoft® Windows® XP Professional x64 Edition operating system
(d Microsoft® Windows Server® 2016 operating system

[J Microsoft® Windows Server® 2012 R2 operating system
[d Microsoft® Windows Server® 2012 operating system

[J Microsoft® Windows Server® 2008 R2 operating system
d Microsoft® Windows Server® 2008 operating system

(d Microsoft® Windows Server® 2003 R2 operating system

d Microsoft® Windows Server® 2003 operating system

Mac OS

In this manual, "Mac OS" is used to refer to macOS High Sierra, macOS Sierra, OS X El Capitan, OS X Yosemite,
OS X Mavericks, OS X Mountain Lion, Mac OS X v10.7.x, and Mac OS X v10.6.8.
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Important Instructions

Safety Instructions

Read and follow these instructions to ensure safe use of this printer. Make sure you keep this manual for future
reference. Also, be sure to follow all warnings and instructions marked on the printer.

[d Some of the symbols used on your printer are to ensure safety and proper use of the printer. Visit the following
Web site to learn the meaning of the symbols.

http://support.epson.net/symbols

(4 Use only the power cord supplied with the printer and do not use the cord with any other equipment. Use of
other cords with this printer or the use of the supplied power cord with other equipment may result in fire or
electric shock.

[d Be sure your AC power cord meets the relevant local safety standard.

[d Never disassemble, modify, or attempt to repair the power cord, plug, printer unit, scanner unit, or options by
yourself, except as specifically explained in the printer's manuals.

(J Unplug the printer and refer servicing to qualified service personnel under the following conditions:

The power cord or plug is damaged; liquid has entered the printer; the printer has been dropped or the casing
damaged; the printer does not operate normally or exhibits a distinct change in performance. Do not adjust
controls that are not covered by the operating instructions.

[ Place the printer near a wall outlet where the plug can be easily unplugged.

(A Do not place or store the printer outdoors, near excessive dirt or dust, water, heat sources, or in locations
subject to shocks, vibrations, high temperature or humidity.

(d Take care not to spill liquid on the printer and not to handle the printer with wet hands.

[ If the LCD screen is damaged, contact your dealer. If the liquid crystal solution gets on your hands, wash them
thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with
water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.

Safety Instructions for Ink

[d Be careful not to touch ink when you handle the ink tank, ink tank cap, and opened ink bottle or ink bottle cap.
[ If ink gets on your skin, wash the area thoroughly with soap and water.

[ If ink gets into your eyes, flush them immediately with water. If discomfort or vision problems continue after
a thorough flushing, see a doctor immediately.

[ If ink gets into your mouth, see a doctor right away.

(d Do not disassemble the maintenance box; otherwise ink may get into your eyes or on your skin.
[d Do not shake an ink bottle too vigorously or subject it to strong impacts as this can cause ink to leak.

[d Keep ink bottle, the ink tank unit, and maintenance box out of the reach of children. Do not allow children to
drink from or handle the ink bottle and ink bottle cap.
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Printer Advisories and Warnings

Read and follow these instructions to avoid damaging the printer or your property. Make sure you keep this
manual for future reference.

Advisories and Warnings for Setting Up the Printer

(d Do not block or cover the vents and openings in the printer.

[d Use only the type of power source indicated on the printer's label.

[d Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.
(4 Avoid electrical outlets controlled by wall switches or automatic timers.

[d Keep the entire computer system away from potential sources of electromagnetic interference, such as
loudspeakers or the base units of cordless telephones.

(4 The power-supply cords should be placed to avoid abrasions, cuts, fraying, crimping, and kinking. Do not place
objects on top of the power-supply cords and do not allow the power-supply cords to be stepped on or run over.
Be particularly careful to keep all the power-supply cords straight at the ends and the points where they enter
and leave the transformer.

[ If you use an extension cord with the printer, make sure that the total ampere rating of the devices plugged into
the extension cord does not exceed the cord's ampere rating. Also, make sure that the total ampere rating of all
devices plugged into the wall outlet does not exceed the wall outlet's ampere rating.

[ If you plan to use the printer in Germany, the building installation must be protected by a 10 or 16 amp circuit
breaker to provide adequate short-circuit protection and over-current protection for the printer.

(d When connecting the printer to a computer or other device with a cable, ensure the correct orientation of the
connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation
may damage both devices connected by the cable.

[J Place the printer on a flat, stable surface that extends beyond the base of the printer in all directions. The printer
will not operate properly if it is tilted at an angle.

[d Allow space above the printer so that you can fully raise the document cover.
[d Leave enough space in front of the printer for the paper to be fully ejected.

(d Avoid places subject to rapid changes in temperature and humidity. Also, keep the printer away from direct
sunlight, strong light, or heat sources.

Advisories and Warnings for Using the Printer

[d Do not insert objects through the slots in the printer.

(d Do not put your hand inside the printer during printing.

(4 Do not touch the white flat cable and ink tube inside the printer.

(d Do not use aerosol products that contain flammable gases inside or around the printer. Doing so may cause fire.
(4 Do not move the print head by hand; otherwise, you may damage the printer.

(d Be careful not to trap your fingers when closing the document cover.

(d Do not press too hard on the scanner glass when placing the originals.
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[d Prolonged use of the printer when the ink level is below the lower line could damage the printer. Fill the ink
tank to the upper line while the printer is not operating. To display the correct ink level estimates, reset the ink
level after filling the tank.

(d Always turn the printer off using the O button. Do not unplug the printer or turn off the power at the outlet

until the O light stops flashing.

[ If you are not going to use the printer for a long period, be sure to unplug the power cord from the electrical
outlet.

[d When lifting the printer, place your hands in the positions shown below.

Advisories and Warnings for Transporting or Storing the Printer
(d When storing or transporting the printer, avoid tilting it, placing it vertically, or turning it upside down;
otherwise ink may leak.

[d Before transporting the printer, make sure that the print head is in the home (far right) position.

Advisories and Warnings for Using the LCD Screen

[d The LCD screen may contain a few small bright or dark spots, and because of its features it may have an uneven
brightness. These are normal and do not indicate that it is damaged in any way.

(d Only use a dry, soft cloth for cleaning. Do not use liquid or chemical cleaners.

[d The exterior cover of the LCD screen could break if it receives a heavy impact. Contact your dealer if the
screen's surface chips or cracks, and do not touch or attempt to remove the broken pieces.

Protecting Your Personal Information

When you give the printer to someone else or dispose of it, erase all the personal information stored in the printer's
memory by selecting Settings > Restore Default Settings > Clear All Data and Settings on the control panel.

10
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Part Names and Functions

Control panel Indicates the printer's status and allows you to make print settings.
Ink tank cover Open to refill the ink tank.
Ink tank Contains the ink tank.

Paper cassette cover

Open to load paper in the paper cassette.

Front cover

Open when removing jammed paper.

© 6 6 0 0|0

Output tray

Holds the ejected paper.

1
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(1) Document cover Blocks external light while scanning.

(2] Scanner glass Place the originals.

(3] Print head Ink is ejected from the print head nozzles underneath.

(4] Edge guide Feeds the paper straight into the printer. Slide to the edges of the paper.

(5] Paper cassette Loads paper.

(6) Output switch lever Raise to output paper to the output tray. Lower to output paper facing up to
the front of the printer.

(7] Printer cover Open when removing jammed paper.

o (e

Stopper Position the stopper to prevent print outs from falling from the output tray.
USB port Connects a USB cable to connect with a computer.
ACinlet Connects the power cord.

Rear paper feed slot

Loads paper.

Rear cover

Remove when removing jammed paper.

© 6 06 0o o e

Maintenance box cover

Open when replacing the maintenance box.

Control Panel
(1) (2]

|
!

©

2

®)

.

I
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(1) Turns the printer on or off.

Unplug the power cord after checking that the power light is off.

Displays menus and messages. Use buttons on the control panel to select a menu or to make settings.

<]

Displays the solutions when you are in trouble.

Use the A 'V 4P buttons to move the focus to the target, and then press the OK button to open the selected
menu or to make settings.

Stops the current operation.

Starts an operation such as printing or copying.

Applies to a variety of functions depending on the situation.

Returns to the previous screen.

® 06 0 0 o

Displays the home screen.

Guide to the LCD Screen

Menus and messages are displayed on the LCD screen. Select a menu or setting by pressing the A 'V 4P buttons.

Guide to the Home Screen

The following icons and menus are displayed on the home screen.

T

2|
0—|@ C{JD’F&

(@ select Mode -

o When € and P> are displayed, you can scroll right or left by pressing the < or P button.

13
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® | Function icons and names are displayed as menu icons.

Copy Enters Copy menu that allows you to copy a document.

Scan Enters Scan menu that allows you to scan a document or a photo.

Quiet Mode Displays Quiet Mode setting that allows you to reduce the noise the printer makes. However,
enabling this may reduce print speed. Depending on the paper type and print quality settings
you selected, there may be no difference in the printer's noise level.

This is a shortcut to the following menu.
Settings > Printer Setup > Quiet Mode
Settings Enters Settings menu that allows you to make maintenance and printer setup settings.

Maintenance

Access the menus recommended to improve the quality of your printouts. This is a shortcut to
the following menu.

Settings > Maintenance

©® | Available buttons are displayed. In this example, you can proceed to the selected menu by pressing the OK button.

14
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Preparing the Printer

Loading Papers

Available Paper and Capacities

Note:
The paper size displayed differs depending on the driver.

Genuine Epson Paper

Epson recommends using genuine Epson paper to ensure high-quality printouts.

Note:
(A The availability of paper varies by location. For the latest information on paper available in your area, contact Epson
support.

(A When printing on genuine Epson paper at a user defined size, only Standard or Normal print quality settings are
available. Although some printer drivers allow you to select a better print quality, the printouts are printed using
Standard or Normal.

Paper suitable for printing documents |:|

Media Name Size Loading Capacity (Sheets) 2-Sided
Printing
Paper Cassette Rear Paper
Feed Slot
Epson Bright White Ink Jet A4 200 1 v
Paper

Paper suitable for printing documents and photos m

Media Name Size Loading Capacity (Sheets) 2-Sided
Printing
Paper Cassette Rear Paper
Feed Slot
Epson Photo Quiality Ink Jet A4 100 1 -
Paper
Epson Matte Paper- A4 20 1 -
Heavyweight
Epson Double-Sided Matte A4 1 1 -
Paper

15
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Related Information

= “Part Names and Functions” on page 11

Commercially Available Paper

Plain papers

Media Name Size Loading Capacity (Sheets) 2-Sided
Printing
Paper Cassette Rear Paper
Feed Slot
Plain paper Letter, A4 250 1 v
Copy paper B5, 16K (195%270 mm) 250 1 v
Letterhead™
A5, A6, B6 250 1 -
High quality plain paper
Legal, Indian-Legal, 8.5x13 1 1 -
in.
User Defined (mm)™! 1 1 -
89%127 t0 215.9x1200
User Defined (mm)*! - 1 -
54x86 to 215.9x1200
User Defined (mm)”™! 1 1 v
182x257 to 215.9x297

*1  Only printing from computer is available.

*2  Paper on which information such as the sender's name or corporation name are pre-printed in the header. There must be a
margin of 3 mm or more at the top of the paper. 2-sided printing is not available for letterhead paper.

Thick papers

Media Name Size Loading Capacity (Sheets) 2-Sided

Printing
Paper Cassette Rear Paper
Feed Slot
Thick paper Letter, A4, B5, A5, A6, Legal - 1 -
2
(110256 /M) | ey Defined (mm)” - 1 -
89x127 to 215.9x1200

* Only printing from computer is available.

16
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Envelopes
Media Name Size Loading Capacity (Envelopes) 2-Sided Printing
Paper Rear Paper Feed
Cassette Slot
Envelope Envelope #10, Envelope 10 1 -
DL, Envelope C6

Related Information

= “Part Names and Functions” on page 11

Paper Handling Precautions

[d Read the instruction sheets supplied with the paper.

[d To achieve high-quality printouts with genuine Epson paper, use the paper in the environment stated on the
sheets supplied with the paper.

[J Fan and align the edges of the paper before loading. Do not fan or curl photo paper. Doing so may damage the
printable side.

»

[ If the paper is curled, flatten it or curl it slightly in the opposite direction before loading. Printing on curled
paper may cause paper jams and smears on the printout.

[d Do not use paper that is wavy, torn, cut, folded, damp, too thick, too thin, or paper that has stickers stuck to it.
Using these types of paper causes paper jams and smears on the printout.

[d Make sure you are using long-grain paper. If you are not sure what type of paper you are using, check the paper
packaging or contact the manufacturer to confirm the paper specifications.

Related Information

= “Printer Specifications” on page 115
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Loading Paper in the Paper Cassette

1. Open the paper cassette cover until it clicks.

2. Check that the printer is not operating, and then slide out the paper cassette.

g Important:

The paper cassette cannot be removed.

3. Slide the edge guides to their maximum position.
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4. With the printable side facing down, load paper until it touches the back of the paper cassette.

n Important:

Do not load more than the maximum number of sheets specified for the paper.

J 8.5x131in.

Load paper using the line.

[ Legal
Pull out the legal paper guide and load paper using the line.
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5. Slide the edge guides to the edges of the paper.

6. Insert the paper cassette gently.
7. Close the paper cassette cover when loading paper shorter than A4 size.

8.  On the control panel, set the size and type of the paper you loaded in the paper cassette. If your paper size is
not displayed, select User-Defined.

To select an item, move the focus to the item using the AV 4 buttons, and then press the OK button.

Note:
(A You can also display the paper size and paper type settings screen by selecting Settings > Printer Setup > Paper
Source Settings > Paper Setting.

[ For letterhead paper, select Letterhead as the paper type.

[ For letterhead paper, if you print on paper that is smaller than the setting in the printer driver, the printer may print
beyond the edges of the paper which can lead to ink smears on your printouts and excess ink building up inside the
printer. Make sure you select the correct paper size setting.

[ 2-sided printing is not available for letterhead paper. Also, the print speed may be slower.

9. When you load business card size paper, lower the output switch lever to output the paper to the front of the
printer.

Note:
We also recommend outputting envelopes to the front of the printer.

20



User's Guide

Preparing the Printer

Related Information
= “Paper Handling Precautions” on page 17
= “Available Paper and Capacities” on page 15

= “Loading Envelopes and Precautions” on page 22

Loading Paper in the Rear Paper Feed Slot

1. Slide out the edge guides.

)
=

2. Load a single sheet of paper at the center of the rear paper feed slot with the printable side facing up.

(= )
N

(d Envelopes

—
(4 Pre-punched paper

—

000000000000
000000000000

\ 4 \ 4

000000000000

Note:
[d Load a single sheet of paper without binding holes at the top and bottom.

[ Adjust the print position of your file to avoid printing over the holes.
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3. Slide the edge guides to the edges of the paper.

(= )

—e(

4. When you load thick paper or business card size paper, lower the output switch lever to output the paper to
the front of the printer.

Note:
We also recommend outputting envelopes to the front of the printer.

Note:
[ For letterhead paper, select Letterhead as the paper type.

[ For letterhead paper, if you print on paper that is smaller than the setting in the printer driver, the printer may print
beyond the edges of the paper which can lead to ink smears on your printouts and excess ink building up inside the
printer. Make sure you select the correct paper size setting.

[ 2-sided printing is not available for letterhead paper. Also, the print speed may be slower.

Loading Envelopes and Precautions

Load envelopes in the center of the rear paper feed slot short edge first with the flap facing down, and slide the
edge guides to the edges of the envelopes.

S
Ayl
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Load envelopes in the paper cassette with the flap facing up, and then slide the edge guides to the edges of the
envelopes.

[d Fan and align the edges of the envelopes before loading. When the stacked envelopes are puffed up with air,
press them down to flatten them before loading.

e &

(d Do not use envelopes that are curled or folded. Using these envelopes causes paper jams and smears on the
printout.

[d Do not use envelopes with adhesive surfaces on the flaps or window envelopes.

[d Avoid using envelopes that are too thin, as they may curl during printing.

Related Information
= “Available Paper and Capacities” on page 15
= “Loading Paper in the Paper Cassette” on page 18

List of Paper Type

To obtain optimum printing results, select the paper type that suits the paper.

Media Name Media Type

Control Panel Printer Driver
Epson Bright White Ink Jet Paper Plain paper Plain paper
Epson Matte Paper-Heavyweight Matte Epson Matte

Epson Double-Sided Matte Paper

Epson Photo Quality Ink Jet Paper Photo Quiality lJ Epson Photo Quiality Ink Jet
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Outputting Paper

[J Printed paper is ejected to the output tray with the printed side facing down. For A4 size plain paper (with a
thickness of 80g/m?®), up to 100 sheets can be ejected at a time. Outputting more than 100 sheets may cause
paper to fall or a paper jam to occur. Remove any excess paper so that it does not exceed the maximum number
of sheets that can be ejected.

[ When you load thick paper or business card size paper, lower the output switch lever to output paper to the
front of the printer. We also recommend outputting envelopes to the front of the printer.

Placing Originals

Placing Originals on the Scanner Glass

n Important:

When placing bulky originals such as books, prevent exterior light from shining directly onto the scanner glass.

1. Open the document cover.

| S
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Remove any dust or stains on the surface of the scanner glass using a soft, dry, clean cloth.

Note:
If there is any trash or dirt on the scanner glass, the scanning range may expand to include it, so the image of the
original may be displaced or reduced.

Place the original face-down and slide it to the corner mark.

A
o \?

N o >

Note:
A range of 1.5 mm from the corner of the scanner glass is not scanned.

Close the cover gently.

n Important:

Do not apply too much force to the scanner glass or the document cover. Otherwise, they may be damaged.

Remove the originals after scanning.

Note:
If you leave the originals on the scanner glass for a long time, they may stick to the surface of the glass.

Placing an ID Card for Copying

Place an ID card 5 mm away from the corner mark of the scanner glass.

\

] \ ]

|~

=) L
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Menu Options for Settings

Select Settings on the home screen of the printer to make various settings.

Menu Options for Maintenance

Select the menus on the control panel as described below.

Settings > Maintenance

Nozzle Check:

Select this feature to check if the print head nozzles are clogged. The printer prints a nozzle check
pattern.

Head Cleaning:

Select this feature to clean clogged nozzles in the print head.

Power Cleaning:

Select this feature to replace all of the ink inside the ink tube. More ink is consumed than in usual
cleaning. See the "Related Information" below for details on using this feature.

Print Head Alignment:
Select this feature to adjust the print head to improve print quality.

(J Vertical Alignment

Select this feature if your printouts look blurry or text and lines are misaligned.

(J Horizontal Alignment

Select this feature if horizontal banding appears at regular intervals in your printouts.

Reset Ink Level:

Select this feature to reset the ink level to 100% when refilling the ink tank.

Maintenance Box Service Life:

Displays the approximate service life of the maintenance box. When @ is displayed, the

maintenance box is nearly full. When X is displayed, the maintenance box is full.

Paper Guide Cleaning:

Select this feature if there are ink stains on the internal rollers. The printer feeds paper to clean the
internal rollers.

Related Information

= “Cleaning the Print Head (Head Cleaning)” on page 77
= “Aligning the Print Head” on page 80

= “Refilling the Ink Tank” on page 68

= “Cleaning the Paper Path for Ink Smears” on page 81
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Menu Options for Printer Setup

Select the menus on the control panel as described below.

Settings > Printer Setup

Paper Source Settings:

Paper Setting:

Select the paper size and paper type you loaded in the paper sources.

A4/Letter Auto Switching:

Select On to feed paper from the paper source set as A4 size when there is no paper source set
as Letter, or feed from the paper source set as Letter size when there is no paper source set as
A4

Error Notice:

Select On to display an error message when the selected paper size or type does not match the
loaded paper.

Paper Setup Auto Display:
Select On to display the Paper Setting screen when loading paper in the paper cassette.

Quiet Mode:

Select On to reduce noise during printing, however, this may lower the print speed. Depending on
the paper type and print quality settings you selected, there may be no difference in the printer's noise
level.

Power Off Timer:

Your product may have this feature or the Power Off Settings feature depending on the location of
purchase.

Select this setting to turn the printer off automatically when it is not used for a specified period of
time. You can adjust the time before power management is applied. Any increase will affect the
product’s energy efficiency. Please consider the environment before making any change.

Power Off Settings:

Your product may have this feature or the Power Off Timer feature depending on the location of
purchase.

(d Power Off If Inactive

Select this setting to turn the printer off automatically if it is not used for a specified period of
time. Any increase will affect the product’s energy efficiency. Please consider the environment
before making any change.

(d Power Off If Disconnected

Select this setting to turn the printer off after 30 minutes when all ports including the USB port are
disconnected. This feature may not be available depending on your region.

Language:

Select the language used on the LCD screen.
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Sleep Timer:

Adjust the time period to enter a sleep mode (energy saving mode) when the printer has not
performed any operations. The LCD screen turns black when the setting time passes.

Auto Error Solver:

Select an action to perform when a 2-sided printing error or a memory full error occurs.

d On

Displays a warning and prints in single-sided mode when a 2-sided printing error occurs, or prints
only what the printer could process when a memory full error occurs.

0 off

Displays an error message and cancels printing.

Ink Drying Time:

Select the ink drying time you want to use when performing 2-sided printing. The printer prints the
other side after printing one side. If your printout is smeared, increase the time setting.

PC Connection via USB:

Select Enable to allow a computer to access the printer when connected by USB.

Related Information

= “Saving Power - Control Panel” on page 29

Menu Options for Print Status Sheet

Select the menus on the control panel as described below.

Settings > Print Status Sheet

Configuration Status Sheet:

Print information sheets showing the current printer status and settings.

Supply Status Sheet:

Print information sheets showing the status of consumables.

Usage History Sheet:

Print information sheets showing the usage history of the printer.

Menu Options for Print Counter

Select the menus on the control panel as described below.

Settings > Print Counter

Displays the total number of prints from the time you purchased the printer.
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Menu Options for Restore Default Settings

Select the menus on the control panel as described below.

Settings > Restore Default Settings

Resets the following menus to their defaults.
d Copy Settings
(4 Clear All Data and Settings

Menu Options for Firmware Version

Select the menus on the control panel as described below.

Settings > Firmware Version

Displays the current firmware version of your printer.

Saving Power

The printer enters sleep mode or turns off automatically if no operations are performed for a set period. You can
adjust the time before power management is applied. Any increase will affect the product's energy efficiency. Please
consider the environment before making any change.

Depending on the location of purchase, the printer may have a feature that turns it off automatically if it is not
connected for 30 minutes.

Saving Power - Control Panel

1. Select Settings on the home screen.

To select an item, move the focus to the item using the A W 4P buttons, and then press the OK button.
2. Select Printer Setup.

3. Do one of the following.

(4 Select Sleep Timer or Power Off Settings > Power Off If Inactive or Power Off If Disconnected, and then
make settings.

[ Select Sleep Timer or Power Off Timer, and then make settings.

Note:
Your product may have the Power Off Settings or Power Off Timer feature depending on the location of purchase.
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Printing from the Printer Driver on Windows

Accessing the Printer Driver

When accessing the printer driver from the computer's control panel, the settings are applied to all of the
applications.

Accessing the printer driver from the control panel
(1 Windows 10/Windows Server 2016

Click on the start button, and then select Windows System > Control Panel > View devices and printers in
Hardware and Sound. Right-click on your printer, or press and hold it and then select Printing preferences.

[ Windows 8.1/Windows 8/Windows Server 2012 R2/Windows Server 2012

Select Desktop > Settings > Control Panel > View devices and printers in Hardware and Sound. Right-click
on your printer, or press and hold it and then select Printing preferences.

[ Windows 7/Windows Server 2008 R2

Click the start button, and select Control Panel > View devices and printers in Hardware and Sound. Right-
click on your printer and select Printing preferences.

[ Windows Vista/Windows Server 2008

Click the start button, and select Control Panel > Printers in Hardware and Sound. Right-click on your printer
and select Printing preferences.

(J Windows XP/Windows Server 2003 R2/Windows Server 2003

Click the start button, and select Control Panel > Printers and Other Hardware > Printers and Faxes. Right-
click on your printer and select Printing preferences.

Accessing the printer driver from the printer icon on the task bar
The printer icon on the desktop task bar is a shortcut icon allowing you to quickly access the printer driver.

If you click the printer icon and select Printer Settings, you can access the same printer settings window as the one
displayed from the control panel. If you double-click this icon, you can check the status of the printer.

Note:
If the printer icon is not displayed on the task bar, access the printer driver window, click Monitoring Preferences on the
Maintenance tab, and then select Register the shortcut icon to the taskbar.

Printing Basics

Note:
Operations may differ depending on the application. See the application’s help for details.

1. Open the file you want to print.

Load paper in the printer if it has not already been loaded.
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2. Select Print or Page Setup from the File menu.
3. Select your printer.

4. Select Preferences or Properties to access the printer driver window.

=8 EPSON XXX Series Printing Preferences x
Main  More Options  Maintenance
Printing Presets Paper Source Auto Select ~
Add/Remove Presets. .. Document Size A4 210 % 297 mm w
J:] Document - Fast
:! Document - Standard Quality Orientation (@) Portrait (O Landscape
f_”, Document - High Quality
£ Document - 2-Sided Paper Type Plain paper -
Document - 2-Up
EL) Document - 2-Sided with 2-Up Quality Standard v
2-Sided Printing | Off e
Settings... Print Density...
[ Multi-Page off ~ Page Order...
j— - [~
._I P P Copies 1 - Colate
— ilglﬂ ‘_Jllglﬂ [reverse Order
Quiet Mode off -
Show Settings |:| Print Preview
[30b Arranger Lite
Reset Defaults Ink Levels
Sancal oo ek

5. Change the settings as necessary.
See the menu options for the printer driver for details.

Note:
[ You can also see the online help for explanations of the setting items. Right-clicking an item displays Help.

[ When you select Print Preview, you can see a preview of your document before printing.
6. Click OK to close the printer driver window.

7. Click Print.

Note:
When you select Print Preview, a preview window is displayed. To change the settings, click Cancel, and then repeat
the procedure from step 2.

Related Information

= “Available Paper and Capacities” on page 15

= “Loading Paper in the Paper Cassette” on page 18

= “Loading Paper in the Rear Paper Feed Slot” on page 21
= “List of Paper Type” on page 23

= “Main Tab” on page 45
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Printing on 2-Sides

You can print on both sides of the paper. You can also print a booklet that can be created by re-ordering the pages
and folding the printout.

9
/\

I
—
/I

Note:
1 If you do not use paper that is suitable for 2-sided printing, the print quality may decline and paper jams may occur.

[d Depending on the paper and the data, ink may bleed through to the other side of the paper.

Related Information

= “Available Paper and Capacities” on page 15

Print Settings
1. On the printer driver's Main tab, select an option from 2-Sided Printing.

2. Click Settings, make the appropriate settings, and then click OK.
Make settings for Print Density if necessary.

Note:
(A To print a folded booklet, select Booklet.

[d When setting Print Density, you can adjust print density according to the document type.
(A Printing may be slow depending on the combination of options selected for Select Document Type in the Print
Density Adjustment window and for Quality on the Main tab.

3. Click Print.
Related Information

= “Printing Basics” on page 30
= “Main Tab” on page 45
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Printing Several Pages on One Sheet

You can print two or four pages of data on a single sheet of paper.
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Print Settings

On the printer driver's Main tab, select 2-Up or 4-Up as the Multi-Page setting.

Related Information
= “Printing Basics” on page 30
= “Main Tab” on page 45

Printing and Stacking in Page Order (Reverse Order Printing)

You can print from the last page so that documents are stacked in page order for outputting paper to the front of

the printer.
2 Ji

On the printer driver's Main tab, select Reverse Order.

Print Settings

Related Information

= “Printing Basics” on page 30
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= “Main Tab” on page 45

Printing a Reduced or Enlarged Document

You can reduce or enlarge the size of a document by a specific percentage or to fit the paper size you loaded in the
printer.

7
N\ =

Print Settings

On the printer driver's More Options tab, select the document size from the Document Size setting. Select the
paper size you want to print on from the Output Paper setting. Select Reduce/Enlarge Document, and then select
Fit to Page or Zoom to. When you select Zoom to, enter a percentage.

Select Center to print the images in the center of the page.

Related Information
= “Printing Basics” on page 30
= “More Options Tab” on page 45

Printing One Image on Multiple Sheets for Enlargement (Creating a
Poster)

This feature allows you to print one image on multiple sheets of paper. You can create a larger poster by taping

them together.
—

»
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Print Settings

On the printer driver's Main tab, select 2x1 Poster, 2x2 Poster, 3x3 Poster, or 4x4 Poster as the Multi-Page
setting. If you click Settings, you can select the panels that you do not want to print. You can also select the cutting
guide options.

Related Information
= “Printing Basics” on page 30
= “Main Tab” on page 45

Making Posters Using Overlapping Alignment Marks

Here is an example of how to make a poster when 2x2 Poster is selected, and Overlapping Alignment Marks is
selected in Print Cutting Guides.

The actual guides are printed in monochrome, but for this explanation they are shown as blue and red lines.

sheet1I <:> lsheet2

sheet 3 sheet 4
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1. Prepare Sheet 1 and Sheet 2. Cut off the margins of Sheet 1 along the vertical blue line through the center of
the top and bottom cross marks.

4 )

d

sheet2 H B sheet1 ¥ sheet2 K
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2. Place the edge of Sheet 1 on top of Sheet 2 and align the cross marks, then temporarily tape the two sheets
together from the back.

4 )
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¥ sheet1 sheet2 K
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3. Cut the taped sheets in two along the vertical red line through the alignment markers (this time, the line to the
left of the cross marks).
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4. Tape the sheets together from the back.

= [ =
¥ sheet1 sheet2 K
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5. Repeat steps 1 to 4 to tape Sheet 3 and Sheet 4 together.
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6. Cut off the margins of Sheet 1 and Sheet 2 along the horizontal blue line through the center of the left and right
side cross marks.

4 )

B sheet1 sheet2 H
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7. Place the edge of Sheet 1 and Sheet 2 on top of Sheet 3 and Sheet 4 and align the cross marks, and then
temporarily tape them together from the back.
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8. Cut the taped sheets in two along the horizontal red line through the alignment markers (this time, the line
above the cross marks).
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9. Tape the sheets together from the back.

= [ ®
¥ sheet1 sheet2 K

5 sheet 3 i sheet 4 MJE
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10. Cut off the remaining margins along the outer guide.
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Printing with a Header and Footer

You can print information such as a user name and printing date in headers or footers.

(=

oooo oooo

Print Settings

On the printer driver's More Options tab, click Watermark Features, and then select Header/Footer. Click
Settings, and then select the items you want to print.
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Related Information
= “Printing Basics” on page 30
= “More Options Tab” on page 45

Printing a Watermark

You can print a watermark such as "Confidential” or an anti-copy pattern on your printouts. If you print with an
anti-copy pattern, the hidden letters appear when photocopied in order to distinguish the original from the copies.

D__ D__

= |4 Copy mp —

Anti-Copy Pattern is available under the following conditions:

(d Paper: Plain paper, Copy paper, Letterhead, or High quality plain paper
J Quality: Standard

[d Automatic 2-sided printing: Not selected

[ Tone Correction: Automatic

Note:
You can also add your own watermark or anti-copy pattern.

Print Settings
On the printer driver's More Options tab, click Watermark Features, and then select Anti-Copy Pattern or

Watermark. Click Settings to change details such as the size, density, or position of the pattern or the mark.

Related Information
= “Printing Basics” on page 30
= “More Options Tab” on page 45

Printing Multiple Files Together

Job Arranger Lite allows you to combine several files created by different applications and print them as a single
print job. You can specify the print settings for combined files, such as multi-page layout, and 2-sided printing.
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Print Settings

On the printer driver's Main tab, select Job Arranger Lite. When you start printing, the Job Arranger Lite window
is displayed. With the Job Arranger Lite window opened, open the file that you want to combine with the current
file, and then repeat the above steps.

When you select a print job added to Print Project in the Job Arranger Lite window, you can edit the page layout.
Click Print from the File menu to start printing.

Note:
If you close the Job Arranger Lite window before adding all the print data to the Print Project, the print job you are currently
working on is canceled. Click Save from the File menu to save the current job. The extension of the saved files is "ecl".

To open a Print Project, click Job Arranger Lite on the printer driver's Maintenance tab to open the Job Arranger Lite
window. Next, select Open from the File menu to select the file.

Related Information
= “Printing Basics” on page 30
= “Main Tab” on page 45

Adjusting the Print Tone

You can adjust the tone used in the print job.

Il
T

adll

Note:
These adjustments are not applied to the original data.

Print Settings
On the printer driver's More Options tab, select Custom as the Tone Correction setting. Click Advanced to open
the Tone Correction window, and then select the method of tone correction.

Note:
A Automatic is selected as default on the More Options tab. This setting automatically adjusts the tone to match the paper
type and print quality settings.

Related Information

= “Printing Basics” on page 30
= “More Options Tab” on page 45
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Printing to Emphasize Thin Lines

You can thicken thin lines that are too thin to print.

=)

Print Settings

On the printer driver's More Options tab, click Image Options in the Tone Correction setting. Select Emphasize
Thin Lines.

Related Information
= “Printing Basics” on page 30
= “More Options Tab” on page 45

Printing to Enhance Light Text and Lines

You can enhance light letters and lines to make them more visible, or to sharpen images.

Print Settings
On the printer driver's More Options tab, click Image Options in the Tone Correction setting. Select Enhance

Light Text and Lines.

Related Information
= “Printing Basics” on page 30
= “More Options Tab” on page 45
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Printing Clear Bar Codes

You can print a bar code clearly and make it easy to scan. Only enable this feature if the bar code you printed

cannot be scanned.

You can use this feature under the following conditions.

01234

(J Paper: Plain paper, Copy paper, Letterhead, High quality plain paper, Thick paper, or Envelope
(J Quality: Standard

Note:
Deblurring may not always be possible depending on the circumstances.

Print Settings

On the printer driver's Maintenance tab, click Extended Settings, and then select Barcode mode.

Related Information
= “Printing Basics” on page 30
= “Maintenance Tab” on page 46

Canceling Printing

You can cancel a print job from the computer. However, you cannot cancel a print job from the computer once it
has been completely sent to the printer. In this case, cancel the print job by using the printer's control panel.

Canceling

On your computer, right-click on your printer in Devices and Printers, Printer, or in Printers and Faxes. Click
See what's printing, right-click on the job you want to cancel, and then select Cancel.

Menu Options for the Printer Driver

Open the print window in an application, select the printer, and then access the printer driver window.

Note:
Menus vary depending on the option you selected.
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Printing Presets

Add/Remove Presets You can add or remove your own presets for frequently used print

settings. Select the preset you want to use from the list.

Show Settings

Displays a list of items currently set on the Main and More Options tabs.

Reset Defaults

Return all settings to their factory default values. The settings on the More Options tab are also
reset to their defaults.

Ink Levels

Displays the approximate ink levels.

Paper Source

Select the paper source from which the paper is fed. Select Auto Select to automatically select the
paper source selected in Paper Setting on the printer.

Document Size

Select the paper size on which you want to print. If you select User-Defined, enter the paper width
and height.

Orientation Select the orientation you want to use to print.
Paper Type Select the type of paper on which you print.
Quality Select the pint quality you want to use for printing. Available settings depend on the paper type

you select.

2-Sided Printing

Allows you to perform 2-sided printing.

Settings You can specify the binding edge and the binding margins. When
printing multi-page documents, you can select to print starting from
either the front or the back side of the page.

Print Density Select the document type to adjust the print density. If the appropriate
print density is selected, you can prevent images from bleeding through

to the reverse side. Select User Defined to adjust the print density

manually.
Multi-Page Allows you to print several pages on one sheet or perform poster printing. Click Page Order to
specify the order in which pages are printed.
Copies Set the number of copies you want to print.
Collate Prints multi-page documents collated in order and sorted into sets.
Reverse Order Allows you to print from the last page so that the pages are stacked in the
correct order after printing.
Quiet Mode Reduces the noise the printer makes. However, enabling this may reduce print speed.

Print Preview

Displays a preview of your document before printing.

Job Arranger Lite

Select to print using the Job Arranger Lite feature.

More Options Tab

Printing Presets

Add/Remove Presets You can add or remove your own presets for frequently used print

settings. Select the preset you want to use from the list.

Show Settings

Displays a list of items currently set on the Main and More Options tabs.
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Reset Defaults

Return all settings to their factory default values. The settings on the Main tab are also reset to their
defaults.

Document Size

Select the size of your document.

Output Paper

Select the paper size on which you want to print. If the Output Paper differs from the Document
Size, Reduce/Enlarge Document is selected automatically. You do not have to select it when
printing without reducing or enlarging the size of a document.

Reduce/Enlarge

Allows you to reduce or enlarge the size of a document.

Document
Fit to Page Automatically reduce or enlarge the document to fit to the paper size
selected in Output Paper.
Zoom to Prints with a specific percentage.
Center Prints images in the center of the paper.
Tone Correction Automatic Adjusts the tone of images automatically.
Custom Allows you to perform manual tone correction. Click Advanced for

further settings.

Image Options

Enables print quality options such as Emphasize Text. You can also
thicken thin lines to make them visible on the printouts.

Watermark Features

Allows you to make settings for anti-copy pattern or watermarks.

Additional Settings

Rotate 180°

Rotates pages 180 degrees before printing. This feature is helpful when
printing on paper such as envelopes that are loaded in fixed direction in
the printer.

High Speed Prints when the print head moves in both directions. The print speed is
faster, but the quality may decline.
Mirror Image Inverts an image to print as it would appear in a mirror.
Maintenance Tab

Nozzle Check

Prints a nozzle check pattern to check if the print head nozzles are clogged.

Head Cleaning

Cleans the clogged nozzles in the print head. Because this feature uses some ink, clean the print
head only if some nozzles are clogged as shown in the illustration of the nozzle check pattern.
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Power Cleaning

Runs power cleaning to clean the clogged nozzles in the print head. Because this feature uses more
ink than head cleaning, run power cleaning only if most nozzles are clogged as shown in the
illustration of the nozzle check pattern.

Job Arranger Lite Opens the Job Arranger Lite window. Here you can open and edit previously saved data.

EPSON Status Opens the EPSON Status Monitor 3 window. Here you can confirm the status of the printer and the
Monitor 3 consumables.

Monitoring Allows you to make settings for items on the EPSON Status Monitor 3 window.

Preferences

Extended Settings

Allows you to make a variety of settings. Right-click each item to view the Help for more details.

Print Queue

Displays the jobs waiting to be printed. You can check, pause, or resume print jobs.

Printer and Option
Information

Displays the number of sheets of paper fed into the printer.

Language

Changes the language used on the printer driver window. To apply the settings, close the printer
driver, and then open it again.

Software Update

Starts EPSON Software Updater to check for the latest version of applications on the Internet.

Technical Support

Allows you to access the Epson technical support website.

Printing from the Printer Driver on Mac OS

Printing Basics

Note:

Operations differ depending on the application. See the application’s help for details.

1. Open the file you want to print.

Load paper in the printer if it has not already been loaded.

2. Select Print from the File menu or another command to access the print dialog.

If necessary, click Show Details or¥ to expand the print window.

3. Select your printer.

47




User's Guide

Printing

4. Select Print Settings from the pop-up menu.

Printer: EPSON XXXX

Presets: Default Settings

o)

Copies: 1

Pages: © All
From: 1 to: 1

Paper Size: A4 ﬁ 210 by 297 mm
Orientation: T L3 s Scale: 100%
Print Settings B
Paper Source: Auto Select

Media Type: Plain paper
Print Quality: Normal

(O OF O

» Advanced Settings:

Cancel SIS

Note:
On OS X Mountain Lion or later, if the Print Settings menu is not displayed, the Epson printer driver has not been
installed correctly.

Select System Preferences from the :‘. menu > Printers & Scanners (or Print & Scan, Print & Fax), remove the
printer, and then add the printer again. See the following to add a printer.

http://epson.sn

5. Change the settings as necessary.

See the menu options for the printer driver for details.

6. Click Print.

Related Information

= “Available Paper and Capacities” on page 15

= “Loading Paper in the Paper Cassette” on page 18

= “Loading Paper in the Rear Paper Feed Slot” on page 21
= “List of Paper Type” on page 23

= “Menu Options for Print Settings” on page 53
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Printing on 2-Sides

You can print on both sides of the paper.

7
N

I
|
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Note:
1 If you do not use paper that is suitable for 2-sided printing, the print quality may decline and paper jams may occur.

[d Depending on the paper and the data, ink may bleed through to the other side of the paper.

Related Information

= “Available Paper and Capacities” on page 15

Print Settings
Select Two-sided Printing Settings from the pop-up menu. Select the method of 2-sided printing, and then make
the Document Type settings.

Note:
[ Printing speed may be reduced depending on the document type.

[d When printing photos with dense data, select Text & Graphics or Text & Photos in the Document Type setting. If the
printouts are smeared or ink bleeds through to the other side of the paper, adjust the Print Density and Increased Ink
Drying Time in Adjustments.

Related Information

= “Printing Basics” on page 47
= “Menu Options for Two-sided Printing Settings” on page 53
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Printing Several Pages on One Sheet

You can print several pages of data on a single sheet of paper.
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Print Settings

Select Layout from the pop-up menu. Set the number of pages in Pages per Sheet, the Layout Direction (page
order), and Border.

Related Information
= “Printing Basics” on page 47
= “Menu Options for Layout” on page 52

Printing and Stacking in Page Order (Reverse Order Printing)

You can print from the last page so that documents are stacked in page order for outputting paper to the front of

the printer.
2 ji

Select Paper Handling from the pop-up menu. Select Reverse as the Page Order setting.

Print Settings
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Related Information
= “Printing Basics” on page 47
= “Menu Options for Paper Handling” on page 52

Printing a Reduced or Enlarged Document

You can reduce or enlarge the size of a document by a specific percentage or to fit the paper size you loaded in the
printer.

1

/|
N

Print Settings

When printing to fit to the paper size, select Paper Handling from the pop-up menu, and then select Scale to fit
paper size. Select the paper size you loaded in the printer in Destination Paper Size. When reducing the size of
the document, select Scale down only.

When printing at a specific percentage, do one of the following.

[ Select Print from the File menu of the application. Select Printer, enter a percentage in Scale, and then click
Print.

[d Select Page Setup from the File menu of the application. Select your printer in Format For, enter a percentage
in Scale, and then click OK.

Note:
Select the paper size you set in the application as the Paper Size setting.

Related Information
= “Printing Basics” on page 47
= “Menu Options for Paper Handling” on page 52

Canceling Printing

You can cancel a print job from the computer. However, you cannot cancel a print job from the computer once it
has been completely sent to the printer. In this case, cancel the print job by using the printer's control panel.
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Canceling

Click the printer icon in the Dock. Select the job you want to cancel, and then do one of the following.

[ OS X Mountain Lion or later

Click next to the progress meter.

[ Mac OS X v10.6.8 to v10.7.x
Click Delete.

Menu Options for the Printer Driver

Open the print window in an application, select the printer, and then access the printer driver window.

Note:
Menus vary depending on the option you selected.

Menu Options for Layout

Pages per Sheet Select the number of pages to be printed on one sheet.

Layout Direction Specify the order in which the pages will be printed.

Border Prints a border around the pages.

Reverse page Rotates pages 180 degrees before printing. Select this item when printing on paper such as
orientation envelopes that are loaded in fixed direction in the printer.

Flip horizontally Inverts an image to print as it would appear in a mirror.

Menu Options for Color Matching

ColorSync Select the method for color adjustment. These options adjusts colors between the printer and the

computer display to minimize the difference in color.
EPSON Color Controls

Menu Options for Paper Handling

Collate pages Prints multi-page documents collated in order and sorted into sets.
Pages to Print Select to print only odd pages or even pages.
Page Order Select to print from the top or the last page.

Scale to fit paper size Prints to fit to the paper size you loaded.

Destination Paper Select the paper size to print on.
Size
Scale down only Select when reducing the size of the document.
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Menu Options for Cover Page
Print Cover Page Select whether or not to print a cover page. When you want to add a back cover, select After
document.
Cover Page Type Select the contents of the cover page.
Menu Options for Print Settings
Paper Source Select the paper source from which the paper is fed. If the printer has only one paper source, this

item is not displayed. Selecting Auto Select selects the paper source that matches the Paper
Setting on the printer automatically.

Media Type Select the type of paper on which you print.
Print Quality Select the pint quality you want to use for printing. The options vary depending on the paper type.
Advanced Settings Adjusts the brightness and the contrast of images.

Menu Options for Two-sided Printing Settings

Two-sided Printing Prints on both sides of the paper.

Making Operation Settings for the Mac OS Printer Driver

Accessing the Operation Settings Window of the Mac OS Printer Driver

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies > Options (or Driver).

Operation Settings for Mac OS Printer Driver

(1 Skip Blank Page: Avoids printing blank pages.
d Quiet Mode: Reduces the noise the printer makes, however, may reduce print speed.

(d High Speed Printing: Prints when the print head moves in both directions. The print speed is faster, but the
quality may decline.

[ Warning Notifications: Allows the printer driver to display warning notifications.

[ Establish bidirectional communication: Usually, this should be set to On. Select Off when acquiring the printer
information is impossible because the printer is shared with Windows computers on a network or for any other
reason.
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Canceling the Ongoing Job

Press the & button on the printer's control panel to cancel the print job in progress.
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Copying

Copying
1. Load paper in the printer.

2. Place the originals.

3. Select Copy on the home screen.

To select an item, move the focus to the item using the A W 4P buttons, and then press the OK button.

L ] @
=0 O=®
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i Select Mode

4. Set the number of copies.

5. Press the OK button to display and check the print settings. To change the settings, press the ¥ button, select
the setting items and change settings. When you have finished, press the OK button.

Note:
If you want to copy by reducing or enlarging the size of a document by a specific percentage, select any item other than
Auto Fit as the Reduce/Enlarge setting. Specify a percentage in Custom Size. You can change the percentage in

increments of 10% by holding down the € or W button.

6. Press the <> button.

Related Information
= “Placing Originals” on page 24
= “Menu Options for Copying” on page 56

Copying on 2-Sides

1. Select Copy on the home screen.

To select an item, move the focus to the item using the A W 4P buttons, and then press the OK button.
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Press the OK button to display the print settings, and then press the ¥ button.

Select 1>2-Sided as the 2-Sided setting, and then press the OK button.

Select the orientation of the original for the Original Orientation setting, and then press the OK button.
Select the binding direction for the Binding(Copy) setting, and then press the OK button.

Check other print setting items, and change them if necessary, and then press the OK button.

Press the < button.

Related Information

= “Copying” on page 55

Copying Multiple Originals onto One Sheet

1.

Select Copy on the home screen.

To select an item, move the focus to the item using the A W 4P buttons, and then press the OK button.
Press the OK button to display the print settings, and then press the ¥ button.

Select 2-up as the Multi-Page setting, and then press the OK button.

Select the order of the layout for the Layout Order setting, and then press the OK button.

Select the orientation of the original for the Original Orientation setting, and then press the OK button.

Check other print setting items, change them if necessary, and then press the OK button.

Press the < button.

Related Information

= “Copying” on page 55

Menu Options for Copying

Note:
Available menus vary depending on the layout you selected.

The number of copies:

Enter the number of copies.

ID Card Copy:

Scans both sides of an ID card and copies onto one side of A4 size paper.
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2-Sided:
Select 2-sided layout.
0 1->1-Sided
Copies one side of an original onto a single side of paper.
1 1>2-Sided
Copies two single-sided originals onto both sides of a single sheet of paper. Select the orientation of
your original and the binding position of the paper.
Density:
Increase the level of density when the copying results are faint. Decrease the level of density when ink
smears.
Paper Size:

Select the paper size you loaded.

Paper Type:
Select the paper type you loaded.

Paper Setting:

Select the paper source that you want to use.

Reduce/Enlarge:
Enlarges or reduces the originals.
[J Actual Size
Copies at 100 % magnification.
1 Auto Fit

Detects the scan area and automatically enlarges or reduces the original to fit to the paper size you
selected. When there are white margins around the original, the white margins from the corner
mark of the scanner glass are detected as the scan area, but the margins at the opposite side may be
cropped.
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J Custom

Select to specify the magnification to enlarge or reduce the original.

Custom Size:

Specifies the magnification used to enlarge or reduce the original within a range of 25 to 400%.
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Original Size:
Select the size of your original. When copying non-standard size originals, select the size closest to your
original.
Multi-Page:
[ Single Page
Copies a single-sided original onto a single sheet.
A 2-up
Copies two single-sided originals onto a single sheet in 2-up layout. Select the layout order and the
orientation of your original.
Original Type:
Select the type of your original. Copies in optimal quality to match the type of original.
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Scanning

Scanning Using the Control Panel

Scanning to a Computer

Note:
Before scanning, install Epson Scan 2 and Epson Event Manager on your computer.

1. Place the originals.

2. Select Scan on the home screen.

To select an item, move the focus to the item using the A W 4P buttons, and then press the OK button.

it
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3. Select how to save the scanned image to a computer from the following menus, and then press the OK button.
d To Computer (JPEG): Saves the scanned image in JPEG format.
(d To Computer (PDF): Saves the scanned image in PDF format.

(d To Computer (Email): Starts the email client on your computer, and then automatically attaches it to an
email.

d To Computer (Custom): Saves the scanned image using the settings on the Epson Event Manager. You can
change the scan settings such as the scanning size, folder to save to, or save format.

4. Press the <> button.

Related Information

= “Placing Originals” on page 24

Making Custom Settings in Epson Event Manager

You can set the scan settings for To Computer (Custom) in Epson Event Manager.

See the Epson Event Manager help for details.
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Start Epson Event Manager.

Make sure that your scanner is selected as the Scanner on the Button Settings tab on the main screen.

- Epson Event Manager ? *

Button Settings  Folder Settings

Scanner | EFSOM #xRHR ~

Select the action to be launched when the button is pressed.

Save as JPEG EﬁJg Sawve as JPEG - Letter/Color/300 dpi/JPEG/5ave to "Pictures" /Oy
Save as PDF EﬁJg Sawve as PDF - Letter/Color/300 dpi/PDF/Save to "Pictures"/Ope
Aftach to Email EﬁJg Attach to Email - Letter/Color/150 dpi/JPEG/Save to "EpsonEve

Custom Action EﬁJg Custom Action - Letter/Color/300 dpi/JPEG/5ave to "Pictures”; ~

Make Job Settings Job Management

Network Scan Settings

Click Make Job Settings.

2 Epson Event Manager ? X

Button Settings  Folder Settings

Scanner | EPSOM XHMHAK ~

Selectthe action to be launched when the button is pressed.

Save as JPEG /% Save as JPEG - Letter/Celor/300 dpi/JPEG/Save to "Pictures"/Qj
Save as PDF E[i;g Sawve as PDF - Letter/Color/300 dpi/PDF/Save to "Pictures"/Ope
Attach to Email E[i;g Attach to Email - Letter/Color/150 dpifJPEG/Save to "EpsonEve

Custom Action ﬁ?s Custom Action - Letter/Color/300 dpi/JPEG/5ave to "Pictures”) v

Make Job Settings Job Management

TRV R DLl SRS Close
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4. Make scan settings on the Job Settings screen.
2 Job Settinas 7 *
Edit Job Settings
Custom Action ~ —
......... pererern Duplicate
Rename
Delete
Sceff cewngs
Setting Custom b

Detailed Settings for Scanning

Input Source:Auto Detect
Size:Letfter
Image Type:Color

Save Seftings

Target Folder |Fictures w
Filename (Prefix + Start Number) | jmg ”Dm =
File Format | JPEG ~ Save Seftings

JPEG Quality:75

Launch Action

Open Folder v Startup Settings

Test Seftings Cancel

(d Edit Job Settings: Select Custom Action.

[d Setting: Scan using the best settings for the selected type of original. Click Detailed Settings for Scanning
to set the items such as the resolution or the color for saving the scanned image.

[d Target Folder: Select the save folder for the scanned image.

[ Filename (Prefix + Start Number): Change the settings for the file name you want to save.
(1 File Format: Select the save format.

(d Launch Action: Select the action when scanning.

[ Test Settings: Starts test scanning using current settings.

5. Click OK to return to the main screen.
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6. Make sure that the Custom Action is selected on the Custom Action list.

2 Epson Event Manager ? X

Button Seftings  Folder Settings

Scanner | EPSOM X:HRK w

Select the action to be launched when the button is pressed.

Save as JPEG EﬁJg Sawve as JPEG - Letter/Color/300 dpi/JPEG/5ave to "Pictures" /Oy

Save as PDF “ti’?, Sawve as PDF - Letter/Color/300 dpi/PDF/Save to "Pictures"/Ope

attach to Fmail $P8 Attarh #n Ernail - | stbarfCalar/ 180 Anif IDEG Qs #a "EncanFus

Custom Action “ti’?‘, Custom Action - Letter/Color/300 dpi/JPEG/5ave to "Pictures”)

Make Job Settings Job Management

Network Scan Settings

7. Click Close to close Epson Event Manager.

Scanning from a Computer

Scanning Using Epson Scan 2

You can scan using the scanner driver "Epson Scan 2". You can scan originals using detailed settings that are
suitable for text documents.

See the Epson Scan 2 help for an explanation of each setting item.
1. Place the original.

2. Start Epson Scan 2.
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3. Make the following settings on the Main Settings tab.

& Epson Scan2 — O *
Scanner : | EPSON X000 vl
Scan Settings : | Not Selected - |

Main Settings  Advanced Settings

Document Size : |A4 b
Image Type : | Black & White v
Resolution : | 200 ~ | dpi
HuldLe § | u- vl
Correct Document Skew : | Off w

[ Add or edit pages after scanning

Image Format : | PDF - |
File Name : [ imgyyYYMMDD_HHMMSSSS. pdf |
Folder : | Documents V|

e o Preview Scan

(4 Document Size: Select the size of the original you placed.

a & / IE (Original orientation) buttons: Select the set orientation of the original you placed.
Depending on the size of the original, this item may be set automatically and cannot be changed.

(J Image Type: Select the color for saving the scanned image.

[ Resolution: Select the resolution.

Note:
The Document Source setting is fixed as Scanner Glass. You cannot change this setting.

4. Make other scan settings if necessary.

[J You can preview the scanned image by clicking the Preview button. The preview window opens, and the
previewed image is displayed.
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[d On the Advanced Settings tab, you can make detailed image adjustment settings that are suitable for text
documents, such as the following.

[ Remove Background: Remove the background of the originals.
(d Text Enhancement: You can make blurred letters in the original clear and sharp.

(J Auto Area Segmentation: You can make letters clear and images smooth when performing black and
white scanning for a document that contains images.

(d Color Enhance: You can enhance the color specified for the scanned image, and then save it in grayscale
or black and white.

(J Threshold: You can adjust the border for monochrome binary (black and white).
(J Unsharp Mask: You can enhance and sharpen the outlines of the image.

[J Descreening: You can remove moiré patterns (web-like shadows) that appear when scanning printed
papers such as a magazine.

[J Edge Fill: You can remove the shadow created around the scanned image.

(J Dual Image Output (Windows Only): You can scan once and save two images with different output
settings at the same time.

Note:
The items may not be available depending on other settings you made.

5. Set the file saving settings.

& Epson Scan2 — O *
Scanner : | EPSON XXXXX V]
Scan Settings | Mot Selected - |

Main Settings = Advanced Settings

Document Source : | Scanner Glass v|
Document Size : | A4 v|
Image Type : | Black & White v|

Resolution : m dpi

Rotate :

0= |

Correct Document Skew : | off v|

[ Add or edit pages after scanning

Image Format : | FDF ~ |
File Name : [ imgyYYYMMDD_HHMMSSSS.pdf |
Folder : | Documents V|
v u ricvicw Jeant
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(J Image Format: Select the save format from the list.

You can make detailed settings for each save format except BITMAP and PNG. Select Options from the list
after selecting the save format.

[d File Name: Confirm the save file name displayed.

You can change settings for the file name by selecting Settings from the list.

[ Folder: Select the save folder for the scanned image from the list.

You can select another folder or create a new folder by selecting Select from the list.
6. Click Scan.
Related Information

= “Placing Originals” on page 24

= “Application for Scanning Documents and Images (Epson Scan 2)” on page 87
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Refilling Ink and Replacing Maintenance
Boxes

Checking the Status of the Remaining Ink and the
Maintenance Box

You can check the approximate ink levels from the computer.
To confirm the actual ink remaining, visually check the ink level in the printer's tank.

You can check the approximate service life of the maintenance box from the control panel or the computer.

Checking the Status of the Maintenance Box - Control Panel

1. Select Maintenance on the home screen.

To select an item, move the focus to the item using the A W 4P buttons, and then press the OK button.

2. Select Maintenance Box Service Life.

Checking the Status of the Remaining Ink and the Maintenance Box
- Windows

1. Access the printer driver window.

2. Click EPSON Status Monitor 3 on the Maintenance tab.

Note:
If EPSON Status Monitor 3 is disabled, click Extended Settings on the Maintenance tab, and then select Enable
EPSON Status Monitor 3.

Related Information

= “Accessing the Printer Driver” on page 30

Checking the Status of the Remaining Ink and the Maintenance Box
- Mac OS

1. Select System Preferences from the i menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.

3. Click EPSON Status Monitor.
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Ink Bottle Codes

Epson recommends the use of genuine Epson ink bottles.

The following are the codes for genuine Epson ink bottles.

g Important:

[ Epson warranty does not cover damage caused by inks other than those specified, including any genuine Epson
ink not designed for this printer or any third party ink.

[ Other products not manufactured by Epson may cause damage that is not covered by Epson’s warranties, and
under certain circumstances, may cause erratic printer behavior.

Note:
(A Ink bottle codes may vary by location. For the correct codes in your area, contact Epson support.

(A Although the ink bottles may contain recycled materials, this does not affect printer function or performance.

(A Specifications and appearance of the ink bottle are subject to change without prior notice for improvement.

For Europe
Product BK: Black
ET-M2140 111
M2140 110%1/1105*2

*1 High capacity / *2 Standard capacity

Note:
For users in Europe, visit the following website for information on Epson's ink bottle yields.

http://www.epson.eu/pageyield

For Asian countries except for China

BK: Black

005*1 /0055*2

*1 High capacity / *2 Standard capacity

Related Information
= “Technical Support Web Site” on page 124

Ink Bottle Handling Precautions

Read the following instructions before refilling ink.

Storing precautions for ink

[ Store ink bottles at normal room temperature and keep them away from direct sunlight.
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(4 Epson recommends using the ink bottle before the date printed on the package.

[d When storing or transporting an ink bottle, do not tilt the bottle and do not subject it to impacts or temperature
changes. Otherwise, ink may leak even if the cap on the ink bottle is tightened securely. Be sure to keep the ink
bottle upright when tightening the cap, and take precautions to prevent ink from leaking when transporting the
bottle, for example, putting the bottle in a bag.

[d After bringing an ink bottle inside from a cold storage site, allow it to warm up at room temperature for at least
three hours before using it.

(d Do not open the ink bottle package until you are ready to fill the ink tank. The ink bottle is vacuum packed to
maintain its reliability. If you leave an ink bottle unpacked for a long time before using it, normal printing may
not be possible.

Handling precautions for refilling ink

[d To ensure you receive premium print quality and to help protect your print head, a variable ink safety reserve
remains in the ink tank when your printer indicates to refill ink. The yields quoted for you do not include this
reserve.

(d For optimum print results do not maintain low ink levels for extended periods of time.

(d Although the ink bottles may contain recycled materials, this does not affect printer function or performance.
[J Specifications and appearance of the ink bottle are subject to change without prior notice for improvement.
[d Use ink bottles with the correct part code for this printer.

(d This printer requires careful handling of ink. Ink may splatter when the ink tank is filled or refilled with ink. If
ink gets on your clothes or belongings, it may not come off.

(4 Do not shake too vigorously or squeeze the ink bottles.
[d Once you open an ink bottle, we recommend using it as soon as possible.

[d Prolonged use of the printer when the ink level is below the lower line could damage the printer. Epson
recommends filling the ink tank to the upper line when the printer is not operating to reset the ink level.

(d To obtain optimum printing results, refill the ink tank to the upper line at least once every year.

[ Visually check ink levels in the actual ink tanks. Continued use of the printer when the ink is expended could
damage the printer. Epson recommends filling the ink tank to the upper line when the printer is not operating
to reset the ink level.

Ink consumption

(d To maintain optimum print head performance, some ink is consumed from the ink tank during maintenance
operations such as print head cleaning. Ink may also be consumed when you turn the printer on.

[d The ink in the ink bottle supplied with your printer is partly used during initial setup. In order to produce high
quality printouts, the print head in your printer will be fully charged with ink. This one-off process consumes a
quantity of ink and therefore this bottle may print fewer pages compared to subsequent ink bottles.

d Quoted yields may vary depending on the images that you are printing, the paper type that you are using, the
frequency of your prints and environmental conditions such as temperature.

Refilling the Ink Tank

1. Select Maintenance on the home screen.

To select an item, move the focus to the item using the AV 4 buttons, and then press the OK button.
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2. Select Reset Ink Level.
3. Press the OK button.

4. Open the ink tank cover.

5. Open the ink tank cap.

6. While holding the ink bottle upright, turn the cap slowly to remove it.

o
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n Important:

(d Be careful not to spill any ink.
(d Do not touch the top of the ink bottle after removing the cap; otherwise you may be smeared with ink.

d Do not dispose of the top of the cap or the cap cover. If any ink remains in the ink bottle after refilling the
tank, use the top of the cap or cap cover to seal the ink bottle cap.

7. Position the top of the ink bottle along the slot in front of the filling port, and then stand the bottle slowly to
insert it into the filling port.

n Important:

Do not allow the top of the ink bottle to hit against any objects after removing its cap; otherwise ink may spill.

8. Insert the top of the ink bottle securely into the filling port of the tank to refill the tank with ink.

Ink pours into the tank just by holding the bottle normally without squeezing. The ink flow stops
automatically when the ink is filled to the upper line.

N
S
—

J
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Note:
If the ink does not start flowing into the tank, remove the ink bottle and try reinserting it.

9. When you have finished refilling the ink, remove the ink bottle, and then close the cap of the ink tank securely.

/

g Important:

Do not leave the ink bottle inserted; otherwise the bottle may be damaged or ink may leak.

Note:
If any ink remains in the ink bottle, tighten the cap and store the bottle upright for later use.

K

10. Close the ink tank cover firmly.

11. Press the <> button to reset the ink level.
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12. Confirm the message, and then press the <> button.

n Important:

If you continue to use the printer after resetting the ink level without refilling the ink tank to the upper line, printing
may be performed without ink and this may damage the printer. Before you start printing, make sure you visually
check the ink level of the tank.

Related Information

= “Ink Bottle Codes” on page 67

= “Ink Bottle Handling Precautions” on page 67
= “Ink Spilled” on page 114

Maintenance Box Code

The maintenance box can be purchased and replaced by the user.
Epson recommends the use of a genuine Epson maintenance box.
The following is the code for the genuine Epson maintenance box.

T04D1

n Important:

Once a maintenance box has been installed in a printer it cannot be used with other printers.

Maintenance Box Handling Precautions

Read the following instructions before replacing the maintenance box.

(d Do not touch the green chip on the side of the maintenance box. Doing so may prevent normal operation and
printing.

(4 Do not drop the maintenance box or subject it to strong shocks.
(d Do not replace the maintenance box during printing; otherwise, ink may leak.

(4 Do not remove the maintenance box and its cover except when replacing the maintenance box; otherwise ink
may leak.

[ When the cover cannot be reattached, the maintenance box may not be installed correctly. Remove the
maintenance box, and re-install it.

[d Do not tilt the used maintenance box until after it is sealed in the plastic bag; otherwise ink may leak.
(d Do not touch the openings in the maintenance box as you may get smeared with ink.

(d Do not reuse a maintenance box which has been removed and left detached for a long period. Ink inside the box
will have solidified and no more ink can be absorbed.

(d Keep the maintenance box out of direct sunlight.

[ Do not store the maintenance box in high or freezing temperatures.
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Replacing a Maintenance Box

In some print cycles a very small amount of surplus ink may be collected in the maintenance box. To prevent ink
leakage from the maintenance box, the printer is designed to stop printing when the absorbing capacity of the
maintenance box has reached its limit. Whether and how often this is required will vary according to the number
of pages you print, the type of material that you print and the number of cleaning cycles that the printer performs.

When a message is displayed prompting you to replace the maintenance box, refer to the animations displayed on
the control panel. The need for replacement of the box does not mean that your printer has ceased to operate in
accordance with its specifications. The Epson warranty does not cover the cost of this replacement. It is a user-
serviceable part.

Note:

When it is full, you cannot print until the maintenance box is replaced to avoid ink leakage. However, non-printing features
are available.

Related Information

= “Maintenance Box Code” on page 72

= “Maintenance Box Handling Precautions” on page 72

73



User's Guide

Maintaining the Printer

Maintaining the Printer

Preventing the Print Head from Drying

Always use the power button when turning the printer on and off.
Check that the power light is off before you disconnect the power cord.

The ink itself can dry out if it is not covered. Just like placing a cap on a fountain pen or an oil pen to prevent it
from drying, make sure the print head is capped properly to prevent the ink from drying.

When the power cord is unplugged or a power outage occurs while the printer is in operation, the print head may
not be capped properly. If the print head is left as it is, it will dry out causing nozzles (ink outlets) to clog.

In these cases, turn the printer on and off again as soon as possible to cap the print head.

Check if Nozzles are Clogged (Nozzle Check)

If the nozzles are clogged, the printouts become faint or visible banding appears.

When print quality has declined, first use the nozzle check feature to check if the nozzles are clogged.

Check if Nozzles are Clogged (Nozzle Check) - Control Panel
1. Load A4-size plain paper in the paper cassette.

2. Select Maintenance on the home screen.

To select an item, move the focus to the item using the A W 4P buttons, and then press the OK button.
3. Select Nozzle Check.
4. Follow the on-screen instructions to print the nozzle check pattern.

5. Examine the printed pattern, and then perform one of the following options depending on the print results.

C)NG

A:

All lines are printed. No further steps are needed.
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[d B or close to B: Cleain the print head.
When some nozzles are clogged, select Yes, and then perform head cleaning.

You can still perform head cleaning even if you select No. For details, see the related information below.

4 Cor close to C: Power Clean the print head.

When most lines are broken or most segments are missing, select No, and then perform head cleaning. For
details, see the related information below.

Related Information

= “Loading Paper in the Paper Cassette” on page 18

= “Cleaning the Print Head (Head Cleaning)” on page 77

= “Power Cleaning the Print Head (Power Cleaning)” on page 78

Check if Nozzles are Clogged (Nozzle Check) - Windows
1. Load A4-size plain paper in the printer.

2. Access the printer driver window.

3. Click Nozzle Check on the Maintenance tab.

4. Follow the on-screen instructions to print the nozzle check pattern.

5. Examine the printed pattern, and then perform one of the following options depending on the print results.
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1 A:

All lines are printed. No further steps are needed.

(d B or close to B: Cleain the print head.

When some nozzles are clogged, perform head cleaning. For details, see the related information below.

4 C or close to C: Power Clean the print head.

When most lines are broken or most segments are missing, perform head cleaning. For details, see the
related information below.

Related Information

= “Accessing the Printer Driver” on page 30
= “Loading Paper in the Paper Cassette” on page 18
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= “Cleaning the Print Head (Head Cleaning)” on page 77

= “Power Cleaning the Print Head (Power Cleaning)” on page 78

Check if Nozzles are Clogged (Nozzle Check) - Mac OS

1.

Load A4-size plain paper in the printer.

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

Click Options & Supplies > Utility > Open Printer Utility.
Click Nozzle Check.
Follow the on-screen instructions to print the nozzle check pattern.

Examine the printed pattern, and then perform one of the following options depending on the print results.

C)NG

1 A:

All lines are printed. No further steps are needed.

(d B or close to B: Cleain the print head.
When some nozzles are clogged, perform head cleaning. For details, see the related information below.
A C or close to C: Power Clean the print head.

When most lines are broken or most segments are missing, perform head cleaning. For details, see the
related information below.

Related Information

= “Loading Paper in the Paper Cassette” on page 18

= “Cleaning the Print Head (Head Cleaning)” on page 77

= “Power Cleaning the Print Head (Power Cleaning)” on page 78
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Cleaning the Print Head (Head Cleaning)

If the nozzles are clogged, the printouts become faint, there is visible banding, or unexpected colors appear. When
print quality has declined, use the nozzle check feature and check if the nozzles are clogged. If the nozzles are
clogged, clean the print head.

n Important:

d Do not open the printer cover or turn off the printer during head cleaning. If the head cleaning is incomplete, you
may not be able to print.

[ Because print head cleaning uses some ink, clean the print head only if quality declines.
(d When ink is low, you may not be able to clean the print head.

[ If print quality has not improved after repeating nozzle check and head cleaning three times, wait for at least six
hours without printing, and then run the nozzle check again and repeat the head cleaning if necessary. We
recommend to turn off the printer. If print quality has still not improved, run Power Cleaning. If it has still not
improved, contact Epson support.

[ To prevent the print head from drying out, do not unplug the printer while the power is on.

Cleaning the Print Head - Control Panel

1. Select Maintenance on the home screen.

To select an item, move the focus to the item using the A ' 4P buttons, and then press the OK button.
2. Select Head Cleaning.

3. Follow the on-screen instructions.

After the print head cleaning is finished, run Nozzle Check and then check if the print head nozzles have been un-
clogged. For details on how to run the nozzle check, see the related information below.

Repeat the steps up to three times until all lines are printed correctly.

Related Information
= “Check if Nozzles are Clogged (Nozzle Check)” on page 74

Cleaning the Print Head - Windows
1. Access the printer driver window.
2. Click Head Cleaning on the Maintenance tab.

3. Follow the on-screen instructions.

After the print head cleaning is finished, run Nozzle Check and then check if the print head nozzles have been un-
clogged. For details on how to run the nozzle check, see the related information below.

Repeat the steps up to three times until all lines are printed correctly.
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Related Information
= “Accessing the Printer Driver” on page 30
= “Check if Nozzles are Clogged (Nozzle Check)” on page 74

Cleaning the Print Head - Mac OS

1. Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.
3. Click Head Cleaning.

4. TFollow the on-screen instructions.

After the print head cleaning is finished, run Nozzle Check and then check if the print head nozzles have been un-
clogged. For details on how to run the nozzle check, see the related information below.

Repeat the steps up to three times until all lines are printed correctly.

Related Information
= “Check if Nozzles are Clogged (Nozzle Check)” on page 74

Power Cleaning the Print Head (Power Cleaning)

The power cleaning feature may improve print quality in the following cases.
[d The most nozzles are clogged.
[J You performed the nozzle check and head cleaning three times and then waited for at least six hours without

printing, but print quality still did not improve.

Before running this feature, use the nozzle check feature to check if the nozzles are clogged, read the following
instructions, and then power clean the print head.

n Important:
Make sure that there is enough ink in the ink tank.

Visually check the ink tank is at least a third full. Low ink levels during Power Cleaning could damage the product.

n Important:

An interval of 12 hours is required between each Power Cleaning.

Normally, a single Power Cleaning should resolve the print quality issue within 12 hours. Therefore, to avoid
unnecessary ink usage, you must wait 12 hours before you try it again.
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n Important:

Maintenance box replacement may be required.

Ink will be deposited to the maintenance box. If it becomes full, you must prepare and install a replacement
maintenance box to continue printing.

Note:
When the ink levels or the free space in the maintenance box are insufficient for Power Cleaning, you cannot run this
feature. Even in this case, the levels and the free space for printing may remain.

Running Power Cleaning - Control Panel

Read the instructions for Power Cleaning before running this feature.

1.

Turn off the printer.

While holding down the @ button, press the O button to display the confirmation screen until the power
light flashes.
Follow the on-screen instructions to run the Power Cleaning feature.

Note:
If you cannot run this feature, solve the problems that are displayed on the screen. Next, follow this procedure from step
1 to run this feature again.

After running this feature, run the nozzle check to make sure the nozzles are not clogged.

For details on how to run the nozzle check, see the related information below.

Related Information

= “Power Cleaning the Print Head (Power Cleaning)” on page 78
= “Check if Nozzles are Clogged (Nozzle Check)” on page 74

Running Power Cleaning - Windows

1.

Access the printer driver window.
Click Power Cleaning on the Maintenance tab.

Follow the on-screen instructions.

Note:
If you cannot run this feature, solve the problems that are displayed on the printer's control panel. Next, follow this
procedure from step 1 to run this feature again.

Related Information

= “Accessing the Printer Driver” on page 30
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Running Power Cleaning - Mac OS

1. Select System Preferences from the i menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.
3. Click Power Cleaning.

4. TFollow the on-screen instructions.

Note:
If you cannot run this feature, solve the problems that are displayed on the printer's control panel. Next, follow this
procedure from step 1 to run this feature again.

Aligning the Print Head

If print results contain the following problems, align the print head to improve the printouts.
[ Vertical lines look misaligned or the printouts look blurry

(J Horizontal banding occurs at regular intervals

Aligning the Print Head - Control Panel

1. Select Maintenance on the home screen.
To select an item, move the focus to the item using the A W 4P buttons, and then press the OK button.
2. Select Print Head Alignment.

3. Select the adjustment menu you want to adjust to improve the printouts according to the status of the print
results.

[d Vertical lines look misaligned or the printouts look blurry : Select Vertical Alignment.

(d Horizontal banding occurs at regular intervals: Select Horizontal Alignment.

4. TFollow the on-screen instructions.

Related Information

= “Loading Paper in the Paper Cassette” on page 18

Cleaning the Paper Path

When the printouts are smeared or paper does not feed correctly, clean the roller inside.

n Important:

Do not use tissue paper to clean the inside of the printer. The print head nozzles may be clogged with lint.
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Cleaning the Paper Path for Ink Smears

When the printouts are smeared or scuffed, clean the roller inside.

n Important:

Do not use tissue paper to clean the inside of the printer. The print head nozzles may be clogged with lint.

1. Load A4-size plain paper in the rear paper feed slot.

2. Select Maintenance on the home screen.

To select an item, move the focus to the item using the A W 4P buttons, and then press the OK button.
3. Select Paper Guide Cleaning.
4. Follow the on-screen instructions to clean the paper path.

Repeat this procedure until the paper is not smeared with ink.

Related Information

= “Loading Paper in the Paper Cassette” on page 18

Cleaning the Paper Path for Paper Feeding Problems
When paper is not fed from paper cassette correctly, clean the roller inside.

1. Turn off the printer by pressing the O button.

2. Unplug the power cord, and then disconnect the power cord.

3. Make sure that the cap of the ink tank is securely closed.

/

®N
g Important:

If the cap of the ink tank is not securely closed, ink may leak.

4. Close the scanner unit.
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5. Slide out the paper cassette, and then remove the paper.

6. Stand the printer on its side with the printer's ink tank at the bottom.

A Caution:

Be careful not to trap your hand or fingers when standing the printer. Otherwise you may be injured.

n Important:

Do not leave the printer standing for a long time.

7. Dampen a soft cloth with water, wring it out thoroughly, and then wipe the roller while rotating it with the
cloth.

A\
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8. Return the printer to its normal position, and then insert the paper cassette.

9. Connect the power cord.

Cleaning the Scanner Glass

When the copies or scanned images are smeared, clean the scanner glass.

n Important:

Never use alcohol or thinner to clean the printer. These chemicals can damage the printer.

1. Open the document cover.

2. Use a soft, dry, clean cloth to clean the surface of the scanner glass.

Important:

[ If the glass surface is stained with grease or some other hard-to-remove material, use a small amount of
glass cleaner and a soft cloth to remove it. Wipe off all remaining liquid.

(4 Do not press the glass surface too hard.

[ Be careful not to scratch or damage the surface of the glass. A damaged glass surface can decrease the scan
quality.

Cleaning the Translucent Film

When the printout is not improved after aligning the print head or cleaning the paper path, the translucent film
inside the printer may be smeared.

Items required:
[ Cotton swabs (several)

[d Water with a few drops of detergent (2 to 3 drops of detergent in 1/4 cup of tap water)
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[ Light for checking smears

n Important:

Do not use cleaning liquid other than water with a few drops of detergent.

1.

2.

3.

Turn off the printer by pressing the O button.

Open the printer cover.

Check if the translucent film is smeared. Smears are easier to see if you use a light.

If there are smears (such as finger marks or grease) on the translucent film (A), go to the next step.

N

A: Translucent film

B: Rail

n Important:

Be careful not to touch the rail (B). Otherwise, you may not be able to print. Do not wipe off the grease on the
rail, because this is necessary for operations.
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4. Moisten a cotton swab with the water with a few drops of detergent so that it is not dripping water, and then
wipe the smeared part.

n Important:

Wipe off the smear gently. If you press the cotton swab too hard to the film, the springs of the film may be
dislocated and the printer may be damaged.

5. Use a new dry cotton swab to wipe the film.

n Important:

Do not leave any fibers on the film.

Note:
To prevent the smear from spreading, frequently replace the cotton swab with a new one.

6. Repeat steps 4 and 5 until the film is not smeared.

7. Visually check that the film is not smeared.

Checking the Total Number of Pages Fed Through the
Printer

You can check the total number of pages fed through the printer.

Checking the Total Number of Pages Fed Through the Printer -
Control Panel

The information is printed together with the nozzle check pattern.
1. Load A4-size plain paper in the printer.

2. Select Maintenance on the home screen.

To select an item, move the focus to the item using the A W 4P buttons, and then press the OK button.

3. Select Nozzle Check.
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4. Follow the on-screen instructions to print the nozzle check pattern.

Related Information

= “Loading Paper in the Paper Cassette” on page 18

Checking the Total Number of Pages Fed Through the Printer -
Windows

1. Access the printer driver window.
2. Click Printer and Option Information on the Maintenance tab.

Related Information

= “Accessing the Printer Driver” on page 30

Checking the Total Number of Pages Fed Through the Printer - Mac
os

1. Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.

3. Click Printer and Option Information.
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This section introduces software products available for your printer from the supplied CD.

Application for Scanning Documents and Images
(Epson Scan 2)

Epson Scan 2 is an application for controlling scanning. You can adjust the size, resolution, brightness, contrast,
and quality of the scanned image. You can also start Epson Scan 2 from a TWAIN-compliant scanning application.
See the application's help for details.

Starting on Windows
Note:
For Windows Server operating systems, make sure the Desktop Experience feature is installed.

(1 Windows 10/Windows Server 2016
Click the start button, and then select EPSON > Epson Scan 2.

(1 Windows 8.1/Windows 8/Windows Server 2012 R2/Windows Server 2012

Enter the application name in the search charm, and then select the displayed icon.

(d Windows 7/Windows Vista/Windows XP/Windows Server 2008 R2/Windows Server 2008/Windows Server 2003
R2/Windows Server 2003

Click the start button, and then select All Programs or Programs > EPSON > Epson Scan 2> Epson Scan 2.

Starting on Mac OS
Note:
Epson Scan 2 does not support the Mac OS fast user switching feature. Turn off fast user switching.

Select Go > Applications > Epson Software > Epson Scan 2.
Related Information

= “Scanning Using Epson Scan 2” on page 62
= “Installing Applications” on page 89

Application for Configuring Scanning Operations
from the Control Panel (Epson Event Manager)

Epson Event Manager is an application that allows you to manage scanning from the control panel and save images
to a computer. You can add your own settings as presets, such as the document type, the save folder location, and
the image format. See the application's help for details.

Note:
Windows Server operating systems are not supported.
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Starting on Windows
1 Windows 10

Click the start button, and then select Epson Software > Event Manager.

[d Windows 8.1/Windows 8

Enter the application name in the search charm, and then select the displayed icon.

[J Windows 7/Windows Vista/Windows XP

Click the start button, and then select All Programs or Programs > Epson Software > Event Manager.

Starting on Mac OS

Go > Applications > Epson Software > Event Manager.

Related Information

= “Installing Applications” on page 89

Application for Printing Web Pages (E-Web Print)

E-Web Print is an application that allows you to easily print web pages with various layouts. See the application's
help for details. You can access the help from the E-Web Print menu on the E-Web Print tool bar.

Note:
1 Windows Server operating systems are not supported.

[d Mac OS is not supported.

[ Check for supported browsers and the latest version from the download site.

Starting
When you install E-Web Print, it is displayed in your browser. Click Print or Clip.

Related Information

= “Installing Applications” on page 89

Software Update Tools (EPSON Software Updater)

EPSON Software Updater is an application that checks for new or updated software on the internet and installs it.
You can also update the printer's firmware and manual.

Note:
Windows Server operating systems are not supported.

Installing Method
Download EPSON Software Updater from the Epson website.

If you are using a Windows computer and cannot to download it from the website, you can install it from the
supplied software disc.

http://www.epson.com
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Starting on Windows
([ Windows 10

Click the start button, and then select Epson Software > EPSON Software Updater.
(4 Windows 8.1/Windows 8

Enter the application name in the search charm, and then select the displayed icon.

[J Windows 7/Windows Vista/Windows XP

Click the start button, and then select All Programs or Programs > Epson Software > EPSON Software
Updater.

Note:
You can also start EPSON Software Updater by clicking the printer icon on the task bar on the desktop, and then selecting
Software Update.

Starting on Mac OS
Select Go > Applications > Epson Software > EPSON Software Updater.

Installing Applications

Connect your computer to the network and install the latest version of applications from the website.

Note:
A Log on to your computer as an administrator. Enter the administrator password if the computer prompts you.

[d When reinstalling an application, you need to uninstall it first.
1.  Quit all running applications.

2. When installing the printer driver or Epson Scan 2, disconnect the printer and the computer temporarily.
Note:
Do not connect the printer and the computer until you are instructed to do so.

3. Access to the following website, and then enter the product name.

http://epson.sn
4. Select Setup, and then click Download.

5. Click or double-click the downloaded file, and then follow the on-screen instructions.

Note:
If you are using a Windows computer and you cannot download applications from the website, install them from the
software disc that came with the printer.

Related Information
= “Software Update Tools (EPSON Software Updater)” on page 88
= “Uninstalling Applications” on page 90
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Updating Applications and Firmware

You may be able to clear certain problems and improve or add functions by updating the applications and the
firmware. Make sure you use the latest version of the applications and firmware.

1. Make sure that the printer and the computer are connected, and the computer is connected to the internet.

2. Start EPSON Software Updater, and update the applications or the firmware.

n Important:

Do not turn off the computer or the printer until the update is complete; otherwise, the printer may
malfunction.

Note:
If you cannot find the application you want to update in the list, you cannot update using the EPSON Sofiware
Updater. Check for the latest versions of the applications from your local Epson website.

http://www.epson.com

Uninstalling Applications

Log in to your computer as an administrator. Enter the administrator password if the computer prompts you.

Uninstalling Applications - Windows

1. Press the ®) button to turn off the printer.
2. Quit all running applications.

3. Open Control Panel:
[ Windows 10/Windows Server 2016
Click on the start button, and then select Windows System > Control Panel.
[ Windows 8.1/Windows 8/Windows Server 2012 R2/Windows Server 2012
Select Desktop > Settings > Control Panel.

[ Windows 7/Windows Vista/Windows XP/Windows Server 2008 R2/Windows Server 2008/Windows Server
2003 R2/Windows Server 2003

Click the start button and select Control Panel.

4. Open Uninstall a program (or Add or Remove Programs):

J Windows 10/Windows 8.1/Windows 8/Windows 7/Windows Vista/Windows Server 2016/Windows Server
2012 R2/Windows Server 2012/Windows Server 2008 R2/Windows Server 2008

Select Uninstall a program in Programs.

[ Windows XP/Windows Server 2003 R2/Windows Server 2003
Click Add or Remove Programs.
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Select the application you want to uninstall.

You cannot uninstall the printer driver if there is any print jobs. Delete or wait to be printed the jobs before
uninstalling.

Uninstall the applications:

[d Windows 10/Windows 8.1/Windows 8/Windows 7/Windows Vista/Windows Server 2016/Windows Server
2012 R2/Windows Server 2012/Windows Server 2008 R2/Windows Server 2008

Click Uninstall/Change or Uninstall.
[ Windows XP/Windows Server 2003 R2/Windows Server 2003

Click Change/Remove or Remove.

Note:
If the User Account Control window is displayed, click Continue.

Follow the on-screen instructions.

Uninstalling Applications - Mac OS

1.

Download the Uninstaller using EPSON Software Updater.

Once you have downloaded the Uninstaller, you do not need to download it again each time you uninstall the
application.

Press the () button to turn off the printer.

To uninstall the printer driver, select System Preferences from the ‘ menu > Printers & Scanners (or Print
& Scan, Print & Fax), and then remove the printer from the enabled printers list.

Quit all running applications.
Select Go > Applications > Epson Software > Uninstaller.

Select the application you want to uninstall, and then click Uninstall.

n Important:

The Uninstaller removes all drivers for Epson inkjet printers on the computer. If you use multiple Epson inkjet
printers and you only want to delete some drivers, delete all of them first, and then install the necessary printer
driver again.

Note:

If you cannot find the application you want to uninstall in the application list, you cannot uninstall using the
Uninstaller. In this situation, select Go > Applications > Epson Software, select the application you want to uninstall,
and then drag it to the trash icon.

Related Information
= “Software Update Tools (EPSON Software Updater)” on page 88
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Solving Problems

Checking the Printer Status

Checking Error Codes on the LCD Screen

A code is displayed on the LCD screen if there is an error or information that requires your attention.

Code Situation Solutions

E-01 A printer error has occurred. Open the printer cover and remove any paper or protective material
inside the printer. Turn the power off and on again.

E-02 A scanner error has occurred. Turn the power off and on again.

W-01 A paper jam has occurred. Remove the paper from the printer and press the button displayed on
the bottom of the LCD screen to clear the error. In some cases, you
need to turn the power off and on again.

1-41 Paper Setup Auto Display is If Paper Setup Auto Display is disabled, the Paper Setting screen is

disabled. Some functions cannot be | not displayed when you load paper in the paper cassette.
used.

Recovery The printer has started in recovery Follow the steps below to try to update the firmware again.

Mode mode because the fi date

failed . rmware up 1. Connect the computer and the printer with a USB cable.
2. Visit your local Epson website for further instructions.

Related Information

= “Contacting Epson Support” on page 124

= “Installing Applications” on page 89

= “Updating Applications and Firmware” on page 90

Checking the Printer Status - Windows

1. Access the printer driver window.

2. Click EPSON Status Monitor 3 on the Maintenance tab.

Note:
(A You can also check the printer status by double-clicking the printer icon on the taskbar. If the printer icon is not
added to the taskbar, click Monitoring Preferences on the Maintenance tab, and then select Register the shortcut

icon to the taskbar.

[d If EPSON Status Monitor 3 is disabled, click Extended Settings on the Maintenance tab, and then select Enable

EPSON Status Monitor 3.

Related Information

= “Accessing the Printer Driver” on page 30
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Checking the Printer Status - Mac OS

1. Select System Preferences from the i menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.

3. Click EPSON Status Monitor.

You can check the printer status, ink levels, and error status.

Checking the Software Status

You may be able to clear the problem by updating the software to the latest version. To check the software status,
use the software update tool.

Related Information
= “Software Update Tools (EPSON Software Updater)” on page 88
= “Contacting Epson Support” on page 124

Removing Jammed Paper

Check the error displayed on the control panel and follow the instructions to remove the jammed paper including
any torn pieces. Next, clear the error.

g Important:

(A Remove the jammed paper carefully. Removing the paper vigorously may cause damage to the printer.

[ When removing jammed paper, avoid tilting the printer, placing it vertically, or turning it upside down;
otherwise ink may leak.

Removing Jammed Paper from the Front Cover

A Caution:

Never touch the buttons on the control panel while your hand is inside the printer. If the printer starts operating, it
could cause an injury. Be careful not to touch the protruding parts to avoid injury.
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1. Open the front cover.

2. Lower the output switch lever.

3. Remove the jammed paper.

u Important:

Do not touch the parts inside the printer. Doing so may cause a malfunction.

4. Raise the output switch lever.

5. Close the front cover.
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Removing Jammed Paper from the Rear Paper Feed Slot

Remove the jammed paper.

(= )

¥

Removing Jammed Paper from Inside the Printer

A Caution:

Never touch the buttons on the control panel while your hand is inside the printer. If the printer starts operating, it
could cause an injury. Be careful not to touch the protruding parts to avoid injury.

1.  Open the printer cover, and then use the knob to fasten it to the top.

2.
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n Important:

Do not touch the white flat cable, translucent film, and ink tubes inside the printer. Doing so may cause a
malfunction. If you touch the translucent film, make sure you clean it.

3. Close the printer cover until it clicks.

Related Information

= “Cleaning the Translucent Film” on page 83

Removing Jammed Paper from Rear Cover

1. Remove the rear cover.
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2. Remove the jammed paper.

3. Remove jammed paper from the rear cover.

4. Insert the rear cover in the printer.

Paper Does Not Feed Correctly

Check the following points, and then take the appropriate actions to solve the problem.

[ Place the printer on a flat surface and operate in the recommended environmental conditions.
(4 Use paper supported by this printer.

(4 Follow the paper handling precautions.

(4 Do not load more than the maximum number of sheets specified for the paper.

[ Make sure the paper size and paper type settings match the actual paper size and paper type loaded in the
printer.

(d Clean the roller inside the printer.

Related Information

= “Environmental Specifications” on page 117
= “Paper Handling Precautions” on page 17
= “Available Paper and Capacities” on page 15
= “List of Paper Type” on page 23
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Paper Jams

Load paper in the correct direction, and slide the edge guides against the edges of the paper.

Related Information
= “Removing Jammed Paper” on page 93
= “Loading Paper in the Paper Cassette” on page 18

Paper Feeds at a Slant

Load paper in the correct direction, and slide the edge guides against the edges of the paper.

Related Information

= “Loading Paper in the Paper Cassette” on page 18

Ejected Paper Falls from the Output Tray

If ejected paper falls from the output tray, slide out the stopper to prevent the paper from falling.

Paper is Ejected During Printing

When you load letterhead paper (paper on which information such as the sender's name or corporation name are
pre-printed in the header), select Letterhead as the paper type setting.

Power and Control Panel Problems

Power Does Not Turn On
[d Make sure the power cord is securely plugged in.

O Hold down the O button for a little longer.

Power Does Not Turn Off

Hold down the O button for a little longer. If you still cannot turn off the printer, unplug the power cord. To
prevent the print head from drying out, turn the printer back on and turn it off by pressing the O button.

Power Turns Off Automatically

[d Select Power Off Settings in Settings, and then disable the Power Off If Inactive and Power Off If
Disconnected settings.
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[ Disable the Power Off Timer setting in Settings.

Note:
Your product may have the Power Off Settings or Power Off Timer feature depending on the location of purchase.

LCD Screen Gets Dark

The printer is in sleep mode. Press any button on the control panel to return the LCD screen to its former state.

Cannot Print from a Computer

Checking the Connection (USB)

[d Connect the USB cable securely to the printer and the computer.
[ If you are using a USB hub, try to connect the printer directly to the computer.
[ If the USB cable cannot be recognized, change the port, or change the USB cable.

[ If the printer cannot print using a USB connection, try the following.

Disconnect the USB cable from the computer. Right-click on the printer icon displayed on the computer, and
then select Remove Device. Next, connect the USB cable to the computer and try a test print.

~ Printers (19)
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Checking the Software and Data

[d Make sure that a genuine Epson printer driver is installed. If a genuine Epson printer driver is not installed, the
available functions are limited. We recommend using a genuine Epson printer driver. See the related
information link below for details.

[ If you are printing a large data size image, the computer may run out of memory. Print the image at a lower
resolution or a smaller size.

Related Information

= “Checking for Genuine Epson Printer Drivers” on page 100
= “Installing Applications” on page 89
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Checking for Genuine Epson Printer Drivers

You can check if a genuine Epson printer driver is installed on your computer by using one of the following
methods.

Windows

Select Control Panel > View devices and printers (Printers, Printers and Faxes), and then do the following to
open the print server properties window.

[J Windows 10/Windows 8.1/Windows 8/Windows 7/Windows Server 2016/Windows Server 2012 R2/Windows
Server 2012/Windows Server 2008 R2

Click the printer icon, and then click Print server properties at the top of the window.
[J Windows Vista/Windows Server 2008

Right-click on the Printers folder, and then click Run as administrator > Server Properties.
(d Windows XP/Windows Server 2003 R2/Windows Server 2003

From the File menu, select Server Properties.

Click the Driver tab. If your printer name is displayed in the list, a genuine Epson printer driver is installed on
your computer.
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Mac OS

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and then

select the printer. Click Options & Supplies, and if the Options tab and Utility tab are displayed on the window, a
genuine Epson printer driver is installed on your computer.

Printers & Scanners

General Supply Levels

Open Printer Utility
Print Test Page

Clean Print Heads

cancel (TN

Related Information

= “Installing Applications” on page 89

Checking the Printer Status from the Computer (Windows)

Click Print Queue on the printer driver's Maintenance tab, and then check the following.
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[d Check if there are any paused print jobs.

If unnecessary data remains, select Cancel all documents from the Printer menu.
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[d Make sure the printer is not offline or pending.

If the printer is offline or pending, clear the offline or pending setting from the Printer menu.

[d Make sure the printer is selected as the default printer from the Printer menu (there should be a check mark on
the menu item).

If the printer is not selected as the default printer, set it as the default printer. If there are multiple icons in
Control Panel > View devices and printers (Printers, Printers and Faxes), see the following to select the icon.

Example)
USB connection: EPSON XXXX Series

If you install the printer driver multiple times, copies of printer driver may be created. If copies such as "EPSON
XXXX Series (copy 1)" are created, right-click the copied driver icon, and then click Remove Device.

[d Make sure the printer port is selected correctly in Property > Port from the Printer menu as follows.

Select "USBXXX" for a USB connection.

Checking the Printer Status from the Computer (Mac OS)

Make sure the printer status is not Pause.

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
double-click the printer. If the printer is paused, click Resume (or Resume Printer).

Printout Problems

Printout is Scuffed or Color is Missing

[ If you have not used the printer for a long time, the print head nozzles may be clogged and ink drops may not
be discharged. Perform a nozzle check, and then clean the print head if any of the print head nozzles are
clogged.

(d If you printed when the ink level was too low to be seen in the ink tank window, refill the ink tank to the upper
line and then use the Power Cleaning utility to replace the ink inside the ink tubes. After you use the utility,
perform a nozzle check to see if print quality has improved.

Related Information

= “Check if Nozzles are Clogged (Nozzle Check)” on page 74
= “Refilling the Ink Tank” on page 68

= “Power Cleaning the Print Head (Power Cleaning)” on page 78

102



User's Guide

Solving Problems

Banding or Unexpected Colors Appear

]
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The print head nozzles may be clogged. Perform a nozzle check to check if the print head nozzles are clogged.
Clean the print head if any of the print head nozzles are clogged.

Related Information
= “Check if Nozzles are Clogged (Nozzle Check)” on page 74

Colored Banding Appears at Intervals of Approximately 3.3 cm

[ Select the appropriate paper type setting for the type of paper loaded in the printer.
[J Align the print head using the Horizontal Alignment feature.

[ When printing on plain paper, print using a higher quality setting.
Related Information

= “List of Paper Type” on page 23
= “Aligning the Print Head” on page 80
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Vertical Banding or Misalignment
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[d Align the print head using the Vertical Alignment feature.

[ If print quality does not improve even after aligning the print head, print using a higher quality setting.

Related Information

= “Aligning the Print Head” on page 80

Print Quality is Poor

Check the following if the print quality is poor due to blurry prints, banding, missing colors, faded colors, and
misalignment in the prints.

Checking the printer

[d Make sure the initial ink charging is complete.

[ Refill the ink tank if the ink level is below the lower line.

(d Perform a nozzle check, and then clean the print head if any of the print head nozzles are clogged.

(d Align the print head.

Checking the paper

[d Use paper supported by this printer.

(4 Do not print on paper that is damp, damaged, or too old.
(4 If the paper is curled or the envelope is puffed up, flatten it.
(d Do not stack the paper immediately after printing.

[ Dry the printouts completely before filing or displaying them. When drying the printouts, avoid direct sun light,
do not use a dryer, and do not touch the printed side of paper.

(J When printing images or photos, Epson recommends using genuine Epson paper rather than plain paper. Print
on the printable side of the genuine Epson paper.

Checking the print settings
[J Select the appropriate paper type setting for the type of paper loaded in the printer.
(J Print using a higher quality setting.
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[J During bidirectional (or high speed) printing, the print head prints while moving in both directions, and
vertical lines may be misaligned. If print quality does not improve, disable the bidirectional (or high speed)
setting. Disabling this setting may slow down printing speed.

J Windows
Clear High Speed on the printer driver’s More Options tab.

[d Mac OS

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer. Click Options & Supplies > Options (or Driver). Select Off as the High Speed
Printing setting.

Checking the ink bottle
(4 Use ink bottles with the correct part code for this printer.
(4 Epson recommends using the ink bottle before the date printed on the package.

[ Try to use genuine Epson ink bottles. This product is designed to adjust colors based on the use of genuine
Epson ink bottles. The use of non-genuine ink bottles may cause print quality to decline.

Related Information

= “Check if Nozzles are Clogged (Nozzle Check)” on page 74
= “Aligning the Print Head” on page 80

= “Available Paper and Capacities” on page 15

= “List of Paper Type” on page 23

= “Paper Handling Precautions” on page 17

Paper Is Smeared or Scuffed

(4 When horizontal banding appears or the top or bottom of the paper is smeared, load paper in the correct
direction and slide the edge guides to the edges of the paper.

e 4

[ When vertical banding appears or the paper is smeared, clean the paper path.

|V

[ Place the paper on a flat surface to check if it is curled. If it is, flatten it.
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[d When printing on thick paper, the print head is close to the printing surface and the paper may be scuffed. In
this case, enable the reduce scuff setting. If you enable this setting, print quality may decline or printing may
slow down.

Windows

Click Extended Settings on the printer driver's Maintenance tab, and then select Short Grain Paper.

Related Information
= “Loading Paper in the Paper Cassette” on page 18
= “Cleaning the Paper Path for Ink Smears” on page 81

Paper is Smeared During Automatic 2-Sided Printing

When using the automatic 2-sided printing feature and printing high density data such as images and graphs, set
the print density to lower and the drying time to longer.

Related Information

= “Menu Options for Printer Setup” on page 27

Printed Photos are Sticky

You may be printing on the wrong side of the photo paper. Make sure you are printing on the printable side.

When printing on the wrong side of the photo paper, you need to clean the paper path.

Related Information

= “Cleaning the Paper Path for Ink Smears” on page 81

The Position, Size, or Margins of the Printout Are Incorrect

[d Load paper in the correct direction, and slide the edge guides against the edges of the paper.

[ When placing the originals on the scanner glass, align the corner of the original with the corner indicated by a
symbol on the frame of the scanner glass. If the edges of the copy are cropped off, move the original slightly
away from the corner.

[ When placing the originals on the scanner glass, clean the scanner glass and the document cover. If there is dust
or stains on the glass, the copy area may extend to include the dust or stains, resulting in the wrong copying
position or small images.

[ Select the appropriate Original Size in the copy settings.
[ Select the appropriate paper size setting.

[d Adjust the margin setting in the application so that it falls within the printable area.
Related Information

= “Loading Paper in the Paper Cassette” on page 18
= “Placing Originals on the Scanner Glass” on page 24
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= “Cleaning the Scanner Glass” on page 83
= “Printable Area” on page 115

Printed Characters Are Incorrect or Garbled

[d Connect the USB cable securely to the printer and the computer.
[d Cancel any paused print jobs.

4 Do not put the computer manually into the Hibernate mode or the Sleep mode while printing. Pages of garbled
text may be printed next time you start the computer.

[ If you use the printer driver you had previously used, printed characters may be garbled. Make sure that the
printer driver you are using is for this printer. Check the printer name on the top of the printer driver window.

The Printed Image Is Inverted

Clear any mirror image settings in the printer driver or the application.

J Windows

Clear Mirror Image on the printer driver's More Options tab.

1 Mac OS

Clear Mirror Image from the print dialog's Print Settings menu.

Mosaic-Like Patterns in the Prints

When printing images or photos, print using high-resolution data. Images on websites are often low resolution
although they look good enough on the display, and so print quality may decline.

Uneven Colors, Smears, Dots, or Straight Lines Appear in the Copied
Image

(4 Clean the paper path.
(4 Clean the scanner glass.

(d Do not press too hard on the original or the document cover when you are placing the originals on the scanner
glass.

[d When the paper is smeared, lower the copy density setting.

Related Information

= “Cleaning the Paper Path for Ink Smears” on page 81
= “Cleaning the Scanner Glass” on page 83

= “Menu Options for Copying” on page 56
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Moiré (Cross-Hatch) Patterns Appear in the Copied Image

Change the reduce and enlarge setting or place the original at a slightly different angle.

Related Information

= “Menu Options for Copying” on page 56

An Image of the Reverse Side of the Original Appears in the Copied
Image

[ For a thin original, place the original on the scanner glass and then place a piece of black paper over it.

[d Lower the copy density setting on the control panel.

Related Information

= “Menu Options for Copying” on page 56

The Printout Problem Could Not be Cleared

If you have tried all of the solutions and have not solved the problem, try uninstalling and then reinstalling the
printer driver.

Related Information
= “Uninstalling Applications” on page 90
= “Installing Applications” on page 89

Other Printing Problems

Printing Is Too Slow

[d Close any unnecessary applications.
[d Lower the quality setting. High quality printing slows down the printing speed.

(d Enable the bidirectional (or high speed) setting. When this setting is enabled, the print head prints while
moving in both directions, and the printing speed increases.

J Windows
Select High Speed on the printer driver's More Options tab.

[d Mac OS

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer. Click Options & Supplies > Options (or Driver). Select On as the High Speed
Printing setting.
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[d Disable quiet mode. This feature slows down the printing speed.
[ Control Panel

Select U:]EEU on the home screen, and then disable Quiet Mode.
1 Windows

Select Off as the Quiet Mode setting on the printer driver's Main tab.
d Mac OS

Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer. Click Options & Supplies > Options (or Driver). Select Off as the Quiet Mode
setting.

Printing or Copying Slows Down Dramatically During Continuous
Operation
Printing or Copying slows down to prevent the printer mechanism from overheating and being damaged.

However, you can continue operation. To return to normal speed, leave the printer idle for at least 30 minutes. The
speed does not return to normal if the power is off.

Cannot Start Scanning

(4 Connect the USB cable securely to the printer and the computer. If you are using a USB hub, try to connect the
printer directly to the computer.

[d Make sure that the correct printer (scanner) is selected on Epson Scan 2.

Check whether or not the printer is recognized when using Windows

In Windows, make sure the printer (scanner) is displayed in Scanner and Camera. The printer (scanner) should be
displayed as "EPSON XXXXX (printer name)". If the printer (scanner) is not displayed, uninstall and then re-
install Epson Scan 2. See the following to access Scanner and Camera.

J Windows 10

Click on the start button, and then select Windows System > Control Panel, enter "Scanner and Camera" in the
search charm, click View scanners and cameras, and then check if the printer is displayed.

(J Windows 8.1/Windows 8/Windows Server 2012 R2/Windows Server 2012

Select Desktop > Settings > Control Panel, enter "Scanner and Camera" in the search charm, click Show
Scanner and Camera, and then check if the printer is displayed.

(d Windows 7/Windows Server 2008 R2

Click the start button and select Control Panel, enter "Scanner and Camera" in the search charm, click View
scanners and cameras, and then check if the printer is displayed.

(J Windows Vista/Windows Server 2008

Click the start button, select Control Panel > Hardware and Sound > Scanners and Cameras, and then check
if the printer is displayed.

(d Windows XP/Windows Server 2003 R2/Windows Server 2003

Click the start button, select Control Panel > Printers and Other Hardware > Scanner and Cameras, and then
check if the printer is displayed.
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Related Information
= “Uninstalling Applications” on page 90
= “Installing Applications” on page 89

Scanned Image Problems

Uneven Colors, Dirt, Spots, and so on Appear when Scanning from
the Scanner Glass

[d Clean the scanner glass.
[d Remove any trash or dirt that adheres to the original.

(d Do not press with too much force on the original or the document cover. If you press with too much force,
blurring, smudges, and spots may occur.

Related Information

= “Cleaning the Scanner Glass” on page 83

The Image Quality Is Rough

(d In Epson Scan 2, adjust the image using items on the Advanced Settings tab, and then scan.

[ If the resolution is low, try increasing the resolution and then scanning.

Related Information

= “Scanning Using Epson Scan 2” on page 62

Offset Appears in the Background of Images

Images on the back of the original may appear in the scanned image.

[ In Epson Scan 2, select the Advanced Settings tab, and then adjust the Brightness.

This feature may not be available depending on the settings on the Main Settings tab > Image Type or other
settings on the Advanced Settings tab.

(J In Epson Scan 2, select the Advanced Settings tab, and then Image Option > Text Enhancement.

[ When scanning from the scanner glass, place black paper or a desk pad over the original.
Related Information

= “Scanning Using Epson Scan 2” on page 62
= “Placing Originals” on page 24
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Text is Blurred

(4 In Epson Scan 2, select the Advanced Settings tab, and then Image Option > Text Enhancement.

(d In Epson Scan 2, when Image Type on the Main Settings tab is set to Black & White, adjust the Threshold on
the Advanced Settings tab. When you increase the Threshold, black becomes stronger.

[ If the resolution is low, try increasing the resolution and then scanning.

Related Information

= “Scanning Using Epson Scan 2” on page 62

Moiré Patterns (Web-Like Shadows) Appear

If the original is a printed document, moiré patterns (web-like shadows) may appear in the scanned image.

[ On the Advanced Settings tab in Epson Scan 2, set Descreening.

=

(d Change the resolution, and then scan again.

Related Information

= “Scanning Using Epson Scan 2” on page 62

Cannot Scan the Correct Area on the Scanner Glass

[d Make sure the original is placed correctly against the alignment marks.
[ If the edge of the scanned image is missing, move the original slightly away from the edge of the scanner glass.

[ When scanning from the control panel and selecting the auto scan area cropping function, remove any trash or
dirt from the scanner glass and document cover. If there is any trash or dirt around the original, the scanning
range expands to include it.

Related Information
= “Placing Originals” on page 24
= “Cleaning the Scanner Glass” on page 83

Text is Not Recognized Correctly when Saving as a Searchable PDF

(d On the Image Format Options window in Epson Scan 2, check that Text Language is set correctly on the Text
tab.

[d Check that the original is placed straight.
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[d Use an original with clear text. Text recognition may decline for the following types of originals.

(1 Originals that have been copied a number of times

[J Originals received by fax (at low resolutions)

1 Originals on which the letter spacing or line spacing is too small
[ Originals with ruled lines or underlining over the text

J Originals with hand-written text

J Originals with creases or wrinkles

(d In Epson Scan 2, when Image Type on the Main Settings tab is set to Black & White, adjust the Threshold on

the Advanced Settings tab. When you increase the Threshold, the black color area becomes larger.

(d In Epson Scan 2, select the Advanced Settings tab, and then Image Option > Text Enhancement.

Related Information

= “Scanning Using Epson Scan 2” on page 62

Cannot Solve Problems in the Scanned Image

If you have tried all of the solutions and have not solved the problem, initialize the Epson Scan 2 settings using
Epson Scan 2 Utility.

Note:
Epson Scan 2 Utility is an application that comes with Epson Scan 2.

1.

Start Epson Scan 2 Utility.
[ Windows 10/Windows Server 2016
Click the start button, and then select EPSON > Epson Scan 2 Utility.
(1 Windows 8.1/Windows 8/Windows Server 2012 R2/Windows Server 2012

Enter the application name in the search charm, and then select the displayed icon.

[J Windows 7/Windows Vista/Windows XP/Windows Server 2008 R2/Windows Server 2008/Windows Server
2003 R2/Windows Server 2003

Click the start button, and then select All Programs or Programs > EPSON > Epson Scan 2 > Epson Scan
2 Utility.

4 Mac OS
Select Go > Applications > Epson Software > Epson Scan 2 Utility.

Select the Other tab.

Click Reset.

Note:
If initialization does not solve the problem, uninstall and re-install Epson Scan 2.

Related Information

= “Uninstalling Applications” on page 90

= “Installing Applications” on page 89
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Other Scanning Problems

Scanning Is Too Slow

Lower the resolution.

Scanning Slows Down Dramatically During Continuous Scanning

Scanning slows down to prevent the printer mechanism from overheating and being damaged. However, you can
continue scanning. To return to normal scanning speed, leave the printer idle for at least 30 minutes. Scanning
speed does not return to normal if the power is off.

Scanning Stops when Scanning to PDF/Multi-TIFF

[d When scanning using Epson Scan 2, you can continuously scan up to 999 pages in PDF format and up to 200
pages in Multi-TIFF format.

[d When scanning large volumes, we recommend scanning in grayscale.
[ Increase the free space on the computer's hard disk. Scanning may stop if there is not enough free space.

(d Try scanning at a lower resolution. Scanning stops if the total data size reaches the limit.

Related Information

= “Scanning Using Epson Scan 2” on page 62

Other Problems

Operation Sounds Are Loud

If operations sounds are too loud, enable Quiet Mode. Enabling this feature may reduce printing speed.

(A Control panel

Select OFF on the home screen, and then enable Quiet Mode.

(d Windows printer driver

Enable Quiet Mode on the Main tab.
[ Mac OS printer driver

Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies > Options (or Driver). Select On as the Quiet Mode setting.

(4 Epson Scan 2

Click the O button to open the Configuration window. Next, set the Quiet Mode on the Scan tab.
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Application Is Blocked by a Firewall (for Windows Only)

Add the application to the Windows Firewall allowed program in security settings on the Control Panel.

A Message Prompting You to Reset the Ink Level is Displayed

Refill the ink tank, and then reset the ink level.

Depending on the usage conditions, the message may be displayed when there is still ink in the tank.

Ink Spilled

(J If ink adheres to the area around the tank, wipe it off using a napless, clean cloth or cotton swab.

(J If ink spills on the desk or floor, wipe it off immediately. When ink is dried, it will be difficult to remove the
smear. To prevent the smear from spreading, blot the ink with a dry cloth, and then wipe it with a moist cloth.

[ If ink gets on your hands, wash them with water and soap.
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Technical Specifications

Printer Specifications

Print Head Nozzle Placement

Weight of Paper”

Plain Paper

*

Black ink nozzles: 400x2 rows
Envelopes

64 to 90 g/m*(17 to 24lb)

Envelope #10, DL, C6: 75 to 90 g/m’ (20 to 24 Ib)
depending on the paper properties or quality.

Printable Area

Even when the paper thickness is within this range, the paper may not feed in the printer or the print quality may decline

Printable Area for Single Sheets

Print quality may decline in the shaded areas due to the printer's mechanism
AH Zc A 3.0mm (0.121n.)
B 3.0mm (0.12in.)
C 46.0mm (1.81in.)
D 44,0 mm (1.73in.)
At it
H H
B B
Printable Area for Envelopes
Print quality may decline in the shaded areas due to the printer's mechanism.
AH IC A 3.0 mm (0.121in.)
B 5.0 mm (0.20in.)
C 24.0 mm (0.95 in.)
Af4' ;[D D 46,0 mm (1.81in)
B B
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Scanner Type

Flatbed

Photoelectric Device

cls

Effective Pixels

1020014040 pixels (1200 dpi)

Maximum Document Size

216x297 mm (8.5x11.7 in.)
A4, Letter

Scanning Resolution

1200 dpi (main scan)
2400 dpi (sub scan)

Output Resolution

50 to 9600 dpi in 1 dpi increments

Color Depth Color
[ 48 bits per pixel internal (16 bits per pixel per color internal)
[ 24 bits per pixel external (8 bits per pixel per color external)
Grayscale
[ 16 bits per pixel internal
[ 8 bits per pixel external
Black and white
[ 16 bits per pixel internal
4 1 bits per pixel external
Light Source LED

Interface Specifications

For Computer

Hi-Speed USB

Dimensions

Dimensions

Storage

1 Width: 375 mm (14.8in.)
[ Depth:347 mm (13.7 in.)
1 Height:302 mm (11.9in.)

Printing

d Width: 375 mm (14.8in.)
[ Depth:347 mm (13.7 in.)
4 Height:302 mm (11.9in.)

Weight”

Approx. 6.2 kg (13.7 Ib)
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*  Without the ink and the power cord.
Electrical Specifications
Model 100 to 240 V Model 220 to 240V Model
Rated Frequency Range 50 to 60 Hz 50 to 60 Hz
Rated Current 0.5t00.2A 03A

Power Consumption (with USB Con-
nection)

Standalone copying: Approx. 13.0 W
(ISO/IEC24712)

Ready mode: Approx. 5.0 W
Sleep mode: Approx. 0.7 W
Power off: Approx. 0.2 W

Standalone copying: Approx. 13.0 W
(ISO/IEC24712)

Ready mode: Approx. 5.1 W
Sleep mode: Approx. 0.7 W
Power off: Approx. 0.3 W

Note:

(A Check the label on the printer for its voltage.

(A For European users, see the following Website for details on power consumption.

http://www.epson.eu/energy-consumption

Environmental Specifications

Operation Use the printer within the range shown in the following graph.
%
80
55
20
1 27 35 ©
Temperature: 10 to 35°C (50 to 95°F)
Humidity: 20 to 80% RH (without condensation)
Storage Temperature: -20 to 40°C (-4 to 104°F)"

Humidity: 5 to 85% RH (without condensation)

* You can store for one month at 40°C (104°F).

Environmental Specifications for Ink Bottles

Storage Temperature

-20 to 40 °C (-4 to 104 °F)"

Freezing Temperature

-15°C(5°F)

Ink thaws and is usable after approximately 2 hours at 25 °C (77 °F).
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* You can store for one month at 40 °C (104 °F).

System Requirements

[ Windows 10 (32-bit, 64-bit)/Windows 8.1 (32-bit, 64-bit)/Windows 8 (32-bit, 64-bit)/Windows 7 (32-bit, 64-
bit)/Windows Vista (32-bit, 64-bit)/Windows XP SP3 or later (32-bit)/Windows XP Professional x64 Edition SP2
or later/Windows Server 2016/Windows Server 2012 R2/Windows Server 2012/Windows Server 2008 R2/
Windows Server 2008/Windows Server 2003 R2/Windows Server 2003 SP2 or later

[J macOS High Sierra/macOS Sierra/OS X El Capitan/OS X Yosemite/OS X Mavericks/OS X Mountain Lion/Mac
OS X v10.7.x/Mac OS X v10.6.8
Note:

[ Mac OS may not support some applications and features.

(A The UNIX File System (UFS) for Mac OS is not supported.

Regulatory Information

Standards and Approvals for European Model

The following model is CE marked and in compliance with all the applicable EU Directives. For further details,
visit the following website to access the full declaration of conformities containing reference to the Directives and
harmonized standards used to declare conformity.

http://www.epson.eu/conformity

C651A

Restrictions on Copying

Observe the following restrictions to ensure the responsible and legal use of the printer.
Copying of the following items is prohibited by law:

(d Bank bills, coins, government-issued marketable securities, government bond securities, and municipal
securities

(d Unused postage stamps, pre-stamped postcards, and other official postal items bearing valid postage

d Government-issued revenue stamps, and securities issued according to legal procedure

Exercise caution when copying the following items:

[d Private marketable securities (stock certificates, negotiable notes, checks, etc.), monthly passes, concession
tickets, etc.

(4 Passports, driver’s licenses, warrants of fitness, road passes, food stamps, tickets, etc.

Note:
Copying these items may also be prohibited by law.

Responsible use of copyrighted materials:
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Printers can be misused by improperly copying copyrighted materials. Unless acting on the advice of a
knowledgeable attorney, be responsible and respectful by obtaining the permission of the copyright holder before
copying published material.

Transporting and Storing the Printer

When you need to store the printer or transport it when moving or for repairs, follow the steps below to pack the
printer.
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n Important:

[ When storing or transporting the printer, place the printer in the plastic bag and fold it closed. Avoid tilting the
printer, placing it vertically, or turning it upside down; otherwise ink may leak.

[ When storing or transporting an ink bottle, do not tilt the bottle and do not subject it to impacts or temperature
changes. Otherwise, ink may leak even if the cap on the ink bottle is tightened securely. Be sure to keep the ink
bottle upright when tightening the cap, and take precautions to prevent ink from leaking when transporting the

bottle, for example, putting the bottle in a bag.
A Do not put opened ink bottles in the box with printer.

1. Turn off the printer by pressing the O button.
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2. Make sure the power light turns off, and then unplug the power cord.

n Important:

Unplug the power cord when the power light is off. Otherwise, the print head does not return to the home
position causing the ink to dry, and printing may become impossible.

3. Disconnect all cables such as the power cord and USB cable.
4. Remove all of the paper from the printer.
5. Make sure there are no originals on the printer.

6. Open the printer cover. Secure the print head to the case with tape.

7. Make sure to install the cap onto the ink tank securely.

/

<
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8. Close the Ink Tank Cover securely.

9. Insert the accessory box that came with the printer with the opening flap facing forward as shown below.

10. Place the printer in the plastic bag and fold it closed.

11. Pack the printer in its box using the protective materials.

n Important:

Make sure you keep the printer horizontal when transporting or storing the printer by packing it in its box;
otherwise ink may leak.

When you use the printer again, make sure you remove the tape securing the print head. If print quality has
declined the next time you print, clean and align the print head.

Related Information

= “Part Names and Functions” on page 11

= “Cleaning the Print Head (Head Cleaning)” on page 77
= “Aligning the Print Head” on page 80

Copyright

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any
means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of
Seiko Epson Corporation. No patent liability is assumed with respect to the use of the information contained
herein. Neither is any liability assumed for damages resulting from the use of the information herein. The
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information contained herein is designed only for use with this Epson product. Epson is not responsible for any
use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for
damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of accident, misuse, or
abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.)
failure to strictly comply with Seiko Epson Corporation's operating and maintenance instructions.

Seiko Epson Corporation and its affiliates shall not be liable for any damages or problems arising from the use of
any options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that
occurs from the use of any interface cables other than those designated as Epson Approved Products by Seiko
Epson Corporation.

© 2018 Seiko Epson Corporation

The contents of this manual and the specifications of this product are subject to change without notice.

Trademarks

[ EPSONG® is a registered trademark, and EPSON EXCEED YOUR VISION or EXCEED YOUR VISION is a
trademark of Seiko Epson Corporation.

[d Epson Scan 2 software is based in part on the work of the Independent JPEG Group.
[ libtiff

Copyright © 1988-1997 Sam Leffler

Copyright © 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modity, distribute, and sell this software and its documentation for any purpose is
hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in
all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics
may not be used in any advertising or publicity relating to the software without the specific, prior written
permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED
OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

[ Intel® is a registered trademark of Intel Corporation.

d Microsoft®, Windows®, Windows Server®, and Windows Vista® are registered trademarks of Microsoft
Corporation.

[d Apple, Macintosh, macOS, OS X, and ColorSync are trademarks of Apple Inc., registered in the U.S. and other
countries.

[J Adobe and Adobe Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the
United States and/or other countries.

[d General Notice: Other product names used herein are for identification purposes only and may be trademarks
of their respective owners. Epson disclaims any and all rights in those marks.
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Where to Get Help

Technical Support Web Site

If you need further help, visit the Epson support website shown below. Select your country or region and go to the
support section of your local Epson website. The latest drivers, FAQs, manuals, or other downloadables are also
available from the site.

http://support.epson.net/
http://www.epson.eu/Support (Europe)

If your Epson product is not operating properly and you cannot solve the problem, contact Epson support services
for assistance.

Contacting Epson Support

Before Contacting Epson

If your Epson product is not operating properly and you cannot solve the problem using the troubleshooting
information in your product manuals, contact Epson support services for assistance. If Epson support for your area
is not listed below, contact the dealer where you purchased your product.

Epson support will be able to help you much more quickly if you give them the following information:

[d Product serial number

(The serial number label is usually on the back of the product.)
(4 Product model

[ Product software version

(Click About, Version Info, or similar button in the product software.)
(d Brand and model of your computer
(J Your computer operating system name and version

[d Names and versions of the software applications you normally use with your product

Help for Users in Europe

Check your Pan-European Warranty Document for information on how to contact Epson support.

Help for Users in Taiwan

Contacts for information, support, and services are:

World Wide Web
http://www.epson.com.tw

Information on product specifications, drivers for download, and products enquiry are available.
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Epson HelpDesk

Phone: +886-2-80242008

Our HelpDesk team can help you with the following over the phone:
[ Sales enquiries and product information

(d Product usage questions or problems

[d Enquiries on repair service and warranty

Repair service center:
http://www.tekcare.com.tw/branchMap.page

TekCare corporation is an authorized service center for Epson Taiwan Technology & Trading Ltd.

Help for Users in Singapore

Sources of information, support, and services available from Epson Singapore are:

World Wide Web
http://www.epson.com.sg

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), Sales Enquiries,
and Technical Support via e-mail are available.

Epson HelpDesk

Toll Free: 800-120-5564

Our HelpDesk team can help you with the following over the phone:
[ Sales enquiries and product information

[d Product usage questions or problem troubleshooting

(J Enquiries on repair service and warranty

Help for Users in Thailand

Contacts for information, support, and services are:

World Wide Web
http://www.epson.co.th

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), and e-mail are
available.

Epson Call Centre

Phone: 66-2685-9899

Email: support@eth.epson.co.th

Our Call Centre team can help you with the following over the phone:

[ Sales enquiries and product information
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[J Enquiries on repair service and warranty

Help for Users in Vietham

Contacts for information, support, and services are:

Epson Service Center

65 Truong Dinh Street, District 1, Hochiminh City, Vietnam.
Phone(Ho Chi Minh City): 84-8-3823-9239, 84-8-3825-6234

29 Tue Tinh, Quan Hai Ba Trung, Hanoi City, Vietnam
Phone(Hanoi City): 84-4-3978-4785, 84-4-3978-4775

Help for Users in Indonesia

Contacts for information, support, and services are:

World Wide Web

http://www.epson.co.id

(d Information on product specifications, drivers for download

[ Frequently Asked Questions (FAQ), Sales Enquiries, questions through e-mail

Epson Hotline

Phone: +62-1500-766
Fax: +62-21-808-66-799

Our Hotline team can help you with the following over the phone or fax:

[ Sales enquiries and product information

[ Technical support

Epson Service Center

Province Company Name Address Phone
E-mail

DKI JAKARTA ESS JAKARTA Ruko Mall Mangga Dua No. 48 JI. Arteri (+6221) 62301104

MANGGADUA Mangga Dua, Jakarta Utara - DKI JAKARTA . . . . .

jkt-admin@epson-indonesia.co.id

NORTH ESC MEDAN JI. Bambu 2 Komplek Graha Niaga Nomor (+6261) 42066090 / 42066091

SUMATERA A-4, Medan - North Sumatera . . .
mdn-adm@epson-indonesia.co.id

WEST JAWA ESC BANDUNG JI. Cihampelas No. 48 A Bandung Jawa (+6222) 4207033

Barat 40116 .

bdg-admin@epson-
indonesia.co.id
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Province Company Name Address Phone
E-mail
DI ESC YOGYAKARTA YAP Square, Block A No. 6 JI. C Simanjutak (+62274) 581065
YOGYAKARTA Yogyakarta - DIY . . . .
ygy-admin@epson-indonesia.co.id
EAST JAWA ESC SURABAYA Hitech Mall Lt. 2 Block A No. 24 JI. Kusuma (+6231) 5355035
Bangsa No. 116 - 118 Surabaya - JATIM . . . .
sby-admin@epson-indonesia.co.id
SOUTH ESC MAKASSAR JI. Cendrawasih NO. 3A, kunjung mae, (+62411) 8911071
SULAWESI mariso, MAKASSAR - SULSEL 90125 .
mksr-admin@epson-
indonesia.co.id
WEST ESC PONTIANAK Komp. A yani Sentra Bisnis G33, JI. Ahmad (+62561) 735507 / 767049
KALIMANTAN Yani - Pontianak Kalimantan Barat . .
pontianak-admin@epson-
indonesia.co.id
RIAU ESC PEKANBARU JI. Tuanku Tambusai No.459A Pekanbaru (+62761) 8524695
Ri
fau pkb-admin@epson-
indonesia.co.id
DKI JAKARTA ESS JAKARTA Wisma Keiai Lt. 1 JI. Jenderal Sudirman Kav. (+6221) 5724335
SUDIRMAN 3 Jakarta Pusat - DKI JAKARTA 10220 . . .
ess@epson-indonesia.co.id
EAST JAWA ESS SURABAYA Ruko Surya Inti JI. Jawa No 2-4 Kav. 29 (+6231) 5014949
Surabaya - Jawa Timur . . .
esssby@epson-indonesia.co.id
BANTEN ESS SERPONG Ruko Mall WTC Matahari No. 953, Serpong- (+6221) 53167051 /53167052
Banten . . .
esstag@epson-indonesia.co.id
CENTRAL ESS SEMARANG Komplek Ruko Metro Plaza Block C20 JI. MT (+6224) 8313807 / 8417935
JAWA Haryono No 970 Semarang - JAWA TENGAH . . .
esssmg@epson-indonesia.co.id
EAST ESC SAMARINDA JI. KH. Wahid Hasyim (M. Yamin) Kelurahan (+62541) 7272904
KALIMANTAN Sempaja Selatan Kecamatan Samarinda . . .
UTARA - SAMARINDA - KALTIM escsmd@epson-indonesia.co.id
SOUTH ESC PALEMBANG JI. H.M Rasyid Nawawi No. 249 Kelurahan 9 (+62711) 311330
SUMATERA llir Palembang Sumatera Selatan . . .
escplg@epson-indonesia.co.id
EAST JAVA ESC JEMBER JL. Panglima Besar Sudirman Ruko no.1D (+62331) 488373 / 486468
Jember-Jawa Timur (Depan Balai Penelitian imr-admi -ind . id
& Pengolahan Kakao) jmr-admin@epson-indonesia.co.i
NORTH ESC MANADO Tekno Megamall Lt LG 11 TK 21, Kawasan (+62431) 8890996
SULAWESI Megamas Boulevard, JI Piere Tendean,

Manado - SULUT 95111

MND-ADMIN@EPSON-
INDONESIA.CO.ID

For other cities not listed here, call the Hot Line: 08071137766.

Help for Users in Malaysia

Contacts for information, support, and services are:
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World Wide Web
http://www.epson.com.my
[ Information on product specifications, drivers for download

(d Frequently Asked Questions (FAQ), Sales Enquiries, questions through e-mail

Epson Call Centre

Phone: +60 1800-8-17349

[ Sales enquiries and product information
(d Product usage questions or problems

(4 Enquiries on repair services and warranty

Head Office
Phone: 603-56288288
Fax: 603-5628 8388/603-5621 2088

Help for Users in India

Contacts for information, support, and services are:

World Wide Web
http://www.epson.co.in

Information on product specifications, drivers for download, and products enquiry are available.

Helpline

[ Service, product information, and ordering consumables (BSNL Lines)
Toll-free number: 18004250011
Accessible 9am to 6pm, Monday through Saturday (Except public holidays)

[ Service (CDMA & Mobile Users)
Toll-free number: 186030001600
Accessible 9am to 6pm, Monday through Saturday (Except public holidays)

Help for Users in the Philippines

To obtain technical support as well as other after sales services, users are welcome to contact the Epson Philippines
Corporation at the telephone, fax numbers and e-mail address below:

World Wide Web
http://www.epson.com.ph

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), and E-mail
Enquiries are available.
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Epson Philippines Customer Care

Toll Free: (PLDT) 1-800-1069-37766

Toll Free: (Digital) 1-800-3-0037766

Metro Manila: (+632)441-9030

Web Site: https://www.epson.com.ph/contact

E-mail: customercare@epc.epson.som.ph

Accessible 9am to 6pm, Monday through Saturday (Except public holidays)
Our Customer Care team can help you with the following over the phone:
[ Sales enquiries and product information

[d Product usage questions or problems

(d Enquiries on repair service and warranty

Epson Philippines Corporation
Trunk Line: +632-706-2609
Fax: +632-706-2663
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